Thank you for purchasing TOA's Active Line Array Speaker Systems. Please carefully follow the instructions in this manual to ensure long, trouble-free use of your equipment.
TABLE OF CONTENTS

1. OUTLINE OF SR-D8 PC SOFTWARE ................................................. 4

2. SOFTWARE SETUp ........................................................................... 5
   2.1. SR-D8 PC Software Program Installation .................................... 5
   2.2. Uninstalling the SR-D8 PC Software .......................................... 7

3. STARTING THE SOFTWARE ............................................................. 8
   3.1. Starting from the "Start" Menu .................................................... 8
   3.2. Starting from the Shortcut Icon .................................................. 8

4. INITIAl SCREEN .............................................................................. 9
   4.1. Initial Operation Selection Screen .............................................. 9
   4.2. Menu Item Descriptions ............................................................ 10

5. SysTEm CONFIGURATION SETTING ............................................... 12

6. mAIN SCREEN ............................................................................... 13

7. STACK SETTING ............................................................................ 14
   7.1. Screen Descriptions ................................................................. 14
   7.2. Stack Setting Procedure .......................................................... 19
   7.3. Settings in the DSP View .......................................................... 20
   7.4. Settings in the Mixer View ......................................................... 34
   7.5. Settings in the Beam Steering View .......................................... 43
   7.6. Status View Display and Operation ........................................... 53

8. mUTE All v IEW ............................................................................ 55
   8.1. Mute All View Show/Hide Button ............................................. 55
   8.2. Mute All ON/OFF Switching .................................................... 55
   8.3. Mute Summary ........................................................................ 56

9. COBRANET ROUTING SETTING .................................................... 57
   9.1. CobraNet Routing Setting Mode ............................................... 57
   9.2. Screen Description and Settings When in Normal Mode .......... 58
   9.3. Screen Description and Settings When in Advanced Mode ....... 62
   9.4. CobraNet Parameter Settings .................................................. 64

10. GROUP SETTING .......................................................................... 65
    10.1. Nomenclature of the Grouping Setting View ............................ 65
    10.2. Group Setting ......................................................................... 66
    10.3. Screen Display and Operation at Grouping Setting ................ 67

11. pRESET mEmORy OpERATION ..................................................... 68
    11.1. Preset Memory View Screen Description ................................. 68
    11.2. Preset Memory Recall ............................................................ 70
    11.3. Preset Memory Store .............................................................. 70
    11.4. Preset Memory Name Change ................................................ 71
    11.5. Preset Memory Settings When Power Is ON ............................ 72

12. STORING THE SETTINGS INTO A FILE ...................................... 73
    12.1. Storing Method ...................................................................... 73
12.2. Project Management .......................................................... 74

13. COMMUNICATIONS BETWEEN PC AND SPEAKERS ...... 75
   13.1. Connecting the PC to the Speakers ................................................. 75
   13.2. Enabling Communications between the PC and the Speaker .......... 76
   13.3. Connection Settings (Speakers’ Network Settings) ..................... 76
   13.4. Communications ...................................................................... 80
   13.5. Bulk Receiving .......................................................................... 82
   13.6. Bulk Transmission ..................................................................... 84

14. AUTHORIZATION SETTINGS AND OPERATION .................. 86
   14.1. User Level and Security Settings .................................................. 86
   14.2. Box Write-Protection ................................................................. 90
   14.3. Administrator Log-On .............................................................. 91

15. LOG ............................................................................................ 92
   15.1. Operation Log Settings .............................................................. 92
   15.2. Reference to Operation Logs ...................................................... 93
   15.3. Error Log Settings ................................................................. 96
   15.4. Reference to Error Logs .......................................................... 97

16. GLOSSARY .................................................................................. 100
   16.1 System Basic Items .................................................................. 100
   16.2. PC Software Screen Display .................................................. 102
   16.3. Signal Processing Functions ..................................................... 103
   16.4. System Functions ................................................................... 103
   16.5. Terms Relating to Communication .......................................... 103
   16.6. Terms Relating to Beam Steering ........................................... 104

17. SPECIFICATIONS ....................................................................... 106
   17.1. Software Specifications .......................................................... 106
   17.2. Setting Items, Setting Ranges, and Default Settings .................. 106
1. OUTLINE OF SR-D8 PC SOFTWARE

Equipped with 2 analog and 4 CobraNet inputs, the SR-D8 performs acoustic signal processing for each input audio signal to output sounds through speakers. Also, it features a beam steering function that controls the vertical directivity angle of the audio signals to be radiated from the speaker.

Use the SR-D8 PC Software to set the following functions for the SR-D8.

• Matrix function
• Fader function
• Filter function
• Compressor function
• Delay function
• Beam steering function
• Beam steering simulation function

Settings can be made regardless of whether a PC is communicating (online) or not communicating (offline) with the SR-D8 speaker system. Note that some operations and indications such as level meter indication and compressor reduction indication must be operated or displayed online.

The PC communicates with the SR-D8 via a network. When online with the SR-D8, the PC can perform preset memory loading, setting change of the acoustic signal processing, and beam steering to the SR-D8 in real time. Set parameters can be stored in the PC.

Install the SR-D8 PC Software on a PC meeting with the requirements below.

[Recommended PC requirements]

<table>
<thead>
<tr>
<th>Hardware Requirements</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU</td>
<td>2 GHz, Intel Pentium 4 or faster</td>
</tr>
<tr>
<td>Memory</td>
<td>Over 2 GB</td>
</tr>
<tr>
<td>Display</td>
<td>1280 x 1024 resolution or higher</td>
</tr>
<tr>
<td>Free Hard Disk Space</td>
<td>Over 16 MB however, over 650 MB is required for the 32-bit version or over 1.5 GB for the 64-bit version when Microsoft .NET Framework 4 Client Profile is not yet installed</td>
</tr>
<tr>
<td>Optical Drive</td>
<td>CD-ROM drive</td>
</tr>
<tr>
<td>LAN</td>
<td>100BASE-T or faster connection</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Software Requirements</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>OS</td>
<td>Following are the verified operating systems: Windows 7 Service Pack 1 (Professional) 32-bit/64-bit version Windows 10 Pro 32-bit/64-bit version</td>
</tr>
<tr>
<td>Required Component</td>
<td>.NET Framework 4 Client Profile (Internet access is required if not installed)</td>
</tr>
</tbody>
</table>

- Intel and Pentium are the registered trademarks of Intel Corporation in the United States and other countries.
- Windows is the registered trademark of Microsoft Corporation in the United States and other countries.
- CobraNet is the trademark of Cirrus Logic, Inc.
- Regarding other company names and products, they are also trademarks of individual companies.
2. SOFTWARE SETUP

2.1. SR-D8 PC Software program Installation

Before you start the installation, be sure to exit all software programs. Follow the procedures below to install.

Step 1. Insert the supplied CD into the PC's CD-ROM drive.

Step 2. Open the CD-ROM drive from the "Explorer" or "My Computer." The "English" folder, "Japanese" folder, and other contents are displayed.

Step 3. Open the "English" folder.

Step 4. Open the "SR-D8_Software" folder.

Step 5. Double-click the "setup.exe." The window at right is displayed.

Step 6. Click the [Next] button.

The window at right is displayed. Read through the license terms of the window, and select "I Agree" or "I Do Not Agree" to the license terms. Selecting "I Agree" enables the [Next] button.

Step 7. Confirm the contents of the window, then click the [Next] button.
The window at right is displayed.

**Step 8.** Change the installation folder as needed, then click the [Next] button. The window at right is displayed.

**Step 9.** Install the software program following the on-screen instructions.

**Tip**  
If the .NET Framework is not installed in the PC, follow the on-screen instructions to install it.
Tip
The User Account Control dialog at right may be displayed in the middle of the installation. If the dialog appears, click the [Yes] button to continue installation.

Step 10. Click the [Close] button after installation completion. The shortcut icon for the SR-D8 PC Software is stored in the PC's start menu.

2.2. Uninstalling the SR-D8 PC Software

Step 1. Click the Start button located in the lower left corner of PC screen, then select the “Control Panel.” The Control panel window is displayed.

Step 2. Double-click the "Programs and Features" icon.

Step 3. Select the “SRD8Control.”

Step 4. Click the "Uninstall."
3. STARTING THE SOFTWARE

Following two different methods are available for starting the installed SR-D8 PC Software.

3.1. Starting from the "Start" menu

You can start the SR-D8 PC Software from the start menu.

Click the Start button located in the lower left corner of PC screen, then select [All Programs → TOA Digital Audio Control → SR-D8 PC Software] to start.

3.2. Starting from the Shortcut Icon

You can start the SR-D8 PC Software from the Shortcut Icon on the PC's desktop.

Double-click the "SR-D8 PC Software" desktop shortcut icon to start.
4. INITIAL SCREEN

Starting the SR-D8 PC Software causes the following screen to appear.

4.1. Initial Operation Selection Screen

1. Add Stack button
   Adds a Stack. (See p. 100.)

2. Open button
   Opens the project file stored in the PC.

3. Bulk Receive button
   Automatically detects devices and displays the Bulk receive screen.
4.2. menu Item Descriptions

4.2.1. File

New: Creates (sets) a new project file.
Open: Recalls the existing project file.
Save: Overwrites the project file being edited.
Save as: Saves the project file currently being edited under a new file name.
Exit: Exits the SR-D8 PC Software program.

4.2.2. Edit

Stack
→ Add: Adds the Stack to the Project.
→ Delete: Deletes the Stack from the Project.
→ Copy: Copies the selected Stack parameters into memory.
→ All Parameter Copy: Copies the selected Stack’s all parameters into memory.
→ Beam Steering Parameter Copy: Copies the selected Stack’s Beam Steering parameters into memory.
→ Paste: Pastes the Stack parameters copied into memory.
→ All Parameter Paste: Pastes the Stack’s all parameters copied into memory.
→ Beam Steering Parameter Paste: Pastes the Stack’s Beam Steering parameters copied into memory.
→ Clone: Clones the Stack being selected.
→ Change Name: Changes the Stack name being selected.

Speaker
→ Change Name: Changes the speaker name being selected.

Preset
→ Change Name: Changes the preset memory name.

4.2.3. View

Mute All Show/Hide: Changes "Shows or hides" of the all mute box.

4.2.4. preset

Load
→ Preset 1 – 32: Loads the preset memory into the speaker.

Store
→ Preset 1 – 32: Writes the setting state in one of 32 preset memories.

Power On
→ Last Preset, Preset 1 – 32: Select the preset memory to be recalled at speaker’s power-on from the Last Preset or 32 preset memories.

4.2.5. Communication

Connect: Connects a PC to the speaker for online processing.
Disconnect: Disconnects a PC from the speaker for offline processing.
Tip: While in offline state, the contents changed by a PC are not reflected in the settings of the speaker.

Bulk Transmission: Transmits the project data currently being opened to the speaker.
Bulk Receiving: Receives the speaker’s data.
Setting: Performs speaker’s network settings and sets the speaker’s IP address to which the SR-D8 PC Software can access.
4.2.6. Option

Security Setting: Sets the user level of the SR-D8 PC Software and the restriction of access to the operable items.

Box Write Protect: Sets the prohibition of parameter change in the function box in the Stack DSP view.

Logon Administrator: If you do not log on as an administrator, you can log on as an Administrator for user level.

Logoff Administrator: Logs off an Administrator when logging on as an administrator for the user level by selecting [Option → Log on as an Administrator].

Operating log

→ Setting: Sets the type of the operation for retrieving operation logs for the SR-D8 PC Software.

→ Reference: Refers to the log that was recorded through operations by the SR-D8 PC Software. It also searches and outputs logs to the file.

Beam Steering Parameter Setting: Set the distance displayed in the Beam Steering view. Meters or Feet can be selected.

Error log

→ Setting: Sets the type of error for retrieving error logs that occurred through the SR-D8 PC Software operations.

→ Reference: Refers to the error log that occurred in the SR-D8 PC Software operation. It also searches and outputs logs to the file.

CobraNet Parameter Setting: Performs CobraNet parameter settings.

Edit Receiver Bundle: Sets the received Bundle name and Bundle number of the CobraNet.

Edit Transmitter Bundle: Sets the Bundle number of the transmitted bundle of the CobraNet and makes Output Selector settings.

4.2.7. Help

About: Displays the SR-D8 PC Software version number.
5. SySTEm CONFIGURATION SETTING

Sets the system configuration of the stack (see p. 100) and displays the main screen.

Step 1. Click the [Add Stack] button on the Initial operation selection screen.

Tip
Stack addition can also be performed through the menu operation. (See p. 10.)

The Stack addition Wizard 1 dialog is displayed.

Step 2. Enter a stack name and select a speaker configuration. Up to 16 alphanumeric characters can be used for the stack name.

Notes
• Do not enter the stack name that already exists in the system tree view.
• Do not leave the Stack name field blank. Be sure to assign a name to the Stack.

Step 3. Click the [Next] button.
The Stack addition Wizard 2 dialog is displayed.

Step 4. Enter a speaker name. Up to 16 alphanumeric characters can be used for the speaker name.

Notes
• Do not assign the same name to multiple speakers in a stack.
• Do not leave any speaker name field blank. Be sure to assign a name to the speaker.

Step 5. Click the [Finish] button.
The stack is added in the system tree view, and the signal flow chart is displayed in the operation view in the main view. (See p. 13.)

Step 6. To configure the system with multiple Stacks, add the Stack from the Context menu in the system tree view.
Right-clicking the mouse with the pointer over the area other than the Stack box in the system tree view causes the Context menu to be displayed.
As the Stack addition Wizard 1 dialog is displayed by clicking the displayed "Add Stack," perform the setting in the same way as described in Steps 2 through 5, then a Stack is added.
Repeat this process as many times as needed.
One system is consisting of up to 4 Stacks.
6. MAIN SCREEN

1. System Tree view
Stacks and speakers can be displayed in a tree structure through following operations.
• Adding Stacks on the Initial screen
• Reading the existing project file
• Performing bulk receiving

2. System Configuration View
Displays the following operation views.
• A view for CobraNet routing settings
• A view for Group settings

3. Preset Memory View
The following operations can be performed.
• Displays the number and name of the Preset memory currently assigned to the speaker.
• Recalls the selected Preset memory as speaker settings.
• Stores the setting contents with the selected preset memory number to the speaker.
• Abandons the contents currently being changed and reads the selected preset memory.

4. Main View
Displays various Operation views and Contents views used to perform the on-screen operations and status displays when a stack or speaker is selected in the system tree view or when the CobraNet routing button or Group selection button is clicked.
7. STACk SETTING

7.1. Screen Descriptions

Clicking the Stack in the system tree view displays the signal flow chart in the main view. While the Stack is displayed in the System tree view, clicking the Stack Expand button expands the Stack speaker view.
7.1.1. Stack

Displays Stack state. Selecting the Stack displays the Operation view and Contents view in the main view.

[Stack view (when collapsed)]

1. Stack Expand/Collapse button
   Shows or hides the list display of speakers constituting the Stack.

2. Stack name
   Displays Stack name.

3. Ducker state
   Displays Ducker state. For Ducker, see p. 103.

4. Stack mute
   Double-clicking this button toggles Stack mute ON and OFF. Also, it displays the Stack mute state. The Stack mute can be operated only when online. Stack mute state cannot be stored in a Project (see p. 102).

[Stack view (when expanded)]

1. Stack name

5. IAN communication state
   Displays communication state between the speakers and PC.

6. Local link connection state
   Displays connection state of the audio input applied to the sub-speaker. For local link, see p. 100.

7. CobraNet communication (active) state
   Displays the CobraNet communication (active) state (Primary and Secondary).
8. Fault state
Displays fault state (see p. 101) of the speaker.

- Normal
- Fault*
- Offline

* In this case, the Status indicator on the speaker front also lights up.

9. Protection limiter state
Displays the operation state of the speaker protection limiter.

- Normal
- Protection limiter operating
- Offline

10. Level state
Displays the output level with the meter. The mute icon is displayed when Mute ON is set to any of the speakers belonging to the Stack in the DSP view.

- No sound output
- Sound outputting
- Sound outputting (muted by the DSP)
- Offline
- Offline (muted by the DSP section)

[Context menu (over the Stack box)]
Right-clicking the mouse with the pointer over the Stack box causes the Context menu to open as shown below.

- Delete Stack
  Deletes the Stack from the Project.

- All Parameter Copy
  Copies the selected Stack’s all parameters into memory.

- All Parameter Paste
  Pastes the Stack’s all parameters that have been copied into memory to the selected Stack.

- Clone Stack
  Clones the selected Stack.

- Change Stack name
  Changes the selected Stack name.

[Context menu (over the area other than Stack box)]
Right-clicking the mouse with the pointer over the area other than the Stack box causes the Context menu to open as shown below.

- Add Stack
  Adds Stack to the Project.
7.1.2. Speaker

Displays the state of speakers constituting a Stack (see p. 100) in a list form when the Stack display is expanded. The "Main speaker" of all the speakers constituting a Stack is displayed at the top of the speaker list. Other speakers except the uppermost one are sub-speakers. Selecting the speaker displays the Status view in the main view.

1. Speaker name
   Displays the speaker name.

2. Ip address
   Displays the speaker IP address.

3. Speaker mute
   Double-clicking this button toggles the speaker mute ON and OFF. Also it displays the speaker mute state. The speaker mute can be operated only when online. Speaker mute state cannot be stored in a Project (see p. 102).

4. lan communication state
   Displays the communication state between the speakers and PC.

5. CobraNet communication (active) state
   Displays the CobraNet communication (active) state (Primary and Secondary). The state shows only for the main speaker.

6. Local link connection state
   Displays connection state of the audio input applied to the sub-speaker.
   For local link, see p. 100.

7. Fault state
   Displays the fault state (see p. 101) of the speaker.
8. protection limiter state
Displays the operation state of the speaker protection limiter.

- Normal
- Protection limiter operating
- Offline

9. level state
Displays the output level with the meter.

- No sound output
- Sound outputting
- Sound outputting (muted by the DSP)
- Offline
- Offline (muted by the DSP)

7.1.3. Indications when an error occurs
When a communication error over LAN between a speaker and the PC is detected or when a speaker notifies the PC of various types of errors, this is indicated by changing the corresponding speaker box color into red and the Stack list frame color into orange.

The figures below show an example of indications at error.

[Stack indication at error (when collapsed)]

[Stack indication at error (when expanded)]

[Context menu]
Right-clicking the mouse with the pointer over the speaker box causes the Context menu to open as shown below.

- Change Speaker name
  Changes the selected speaker name.
7.2. Stack Setting procedure

Step 1. Click the Stack in the system tree view. 
Various Operation views and Contents views are displayed in the main view.

Step 2. Click each box in the Operation view. 
The details of the selected box are displayed in the Contents view.

Step 3. Perform the settings in the box or Contents view.

Step 4. Click other tab in the Operation view and perform the settings in the same way. 
There are 3 tabs of DSP, Mixer, and Beam Steering.

[Borderline between the Contents view and the Operation view]

1. Resize handle 
   Dragging the Resize handle in Docking view 
   mode allows the height of the Contents view to be changed.

2. View switching button 
   Switches the Contents view between the fixed display and the enlarged/reduced display.

3. Docking/Floating switching button 
   Switches the Contents view display mode between 
   the Docking and Floating displays.
7.3. Settings in the DSp view

Clicking the DSP tab in the Operation view displays the DSP view. The DSP view displays the signal processing image of the speaker indicated by a signal flow chart consisting of the signal processing functional boxes and input-to-output lines connected between them for each speaker.

![DSP view and Contents view]

7.3.1. Operation

- Selecting each box displays the details in the Contents view.

- Right-clicking the mouse with the pointer over each box (except the Input Meter and Output Meter boxes) displays the Context menu as shown below.

```
Copy
Paste
Clear
```

- **Copy**
  Copies the setting value of the designated (right-clicked) box to the clipboard.

- **Paste**
  Pastes the setting value of the clipboard to the designated (right-clicked) box.

  **Tip**
  "Paste" is active only when you right-click on the box of the same type as the box to which copy has been performed.

- **Clear**
  Initializes the setting value of the designated (right-clicked) box.

- You can also copy the parameters between boxes of the same type in the DSP view by dragging and dropping the box to another speaker's box of the same type.

**Note**

All speakers’ initial box values are grouped in each Stack. If the grouping setting has been canceled or changed, note that a wide difference may be seen in the simulation result of the Beam steering. (For Group setting view, see p. 65.)
7.3.2. Descriptions of DSp view's function boxes and Settings in the Contents view

1. Stack name
   Displays the Stack name.

2. Input Selector
   Input channel and input gain are displayed on the Input selector box.
   
   Example of display when Input channel is "Analog 1" and Input gain "+0 dB"
   
   Example of display when Input channel is "Mix Out 1" and Input gain "+12 dB"

Selecting the box allows the input channel to be selected and input gain to be changed in the Contents view.

[Contents view when the Input selector is selected]

(1) Input gain selection button
   Adjusts the input gain with fixed values (+0 dB, +6 dB, and +12 dB).

(2) Input channel
   Selects the input channel.
   The selected channel is displayed in orange.
3. **Input meter**

Input level is displayed on the Input meter box. Double-clicking the box displays the input levels of each speaker in the Stack in the Contents view.

**Tip:** The meter shows a peak level.

![Contents view when the Input meter is selected](image)

4. **mute**

Mute state in the DSP section is displayed on the Mute box. Double-clicking the mute box toggles Mute ON and OFF in the DSP section.

- : Normal (Mute OFF, not selected mode)
- : Normal (Mute OFF, selected mode)
- : Mute ON (not selected mode)
- : Mute ON (selected mode)

![Contents view when mute is selected](image)

The figure above shows that Speaker 1’s mute is set to ON, while Speakers 2 through 4 are set to normal state (mute OFF). Double-clicking each mute box toggles Mute ON and OFF in the DSP section.

5. **Gain**

Gain is displayed on the Gain box. Gain can be changed on the box or in the Contents view.

![Contents view when Gain is selected](image)

The above 2 figures show an example where Speaker 1’s polarity is “Normal” and gain is “0.0 dB,” and Speaker 2’s polarity is “Inverse” and gain is “10.0 dB.”

1. **polarity reverse button**

Each speaker’s polarity (Normal or Inverse) is displayed on the Polarity reverse button. Clicking this button reverses the polarity.

**Note**

Be sure to match the polarity of all the speakers in a Stack. Failure to do so may result in a wide difference in the Beam Steering simulation result.

2. **Gain indication**

Indicates each speaker’s gain value. You can also change the gain in 0.1 dB units with the Up and Down buttons located on the right side. A gain setting dialog is displayed if gain indication is clicked, enabling you to set the gain by directly entering a numerical value. (Setting range: −20 to +20 dB)

![Gain setting dialog](image)
(3) **Fader**
You can change each speaker’s gain value by moving this fader up and down. Double-clicking the fader box while holding down the PC’s Ctrl key changes the gain value to 0 dB.

6. **lp F/HpF**
Displays overviews of the low pass filter and high pass filter. Selecting the box permits the low pass filter and high pass filter to be set in the Contents view.

![LPF/HPF box]

Overview of the set filter characteristics

[Contents view when lp F/HpF box is selected (graphical display)]

[Contents view when lp F/HpF box is selected (tabular display)]

(1) **Filter control area**
(2) **minimum frequency adjusting button**
Increases or decreases the lower frequency limit on a graduated scale.
(3) Filter point

[Graphical display]
Circles on the filter control area indicate operable filter points. Yellow circles indicate active filter points being selected.

- : Selected filter point (Through)
- : Selected low pass filter (LPF)
- : Selected high pass filter (HPF)
- : Non-selected filter point

[Tabular display]
The first line shows the filter point of high pass filter (HPF) and the second line that of low pass filter (LPF).
The highlighted line is the selected filter point.

(4) maximum frequency adjusting button
Increases or decreases the higher frequency limit on a graduated scale.

(5) maximum amplitude adjusting button
Increases or decreases the higher amplitude limit on a graduated scale.

(6) Filter type display button
Displays the filter type. The pull-down menu shown at right is displayed if this button is clicked, enabling filter type selection.

[Operation in graphical display]
Select the desired filter point in the filter control area, then click this button to select the filter type. Selecting "Through" causes a circle of the filter point to change to a gray circle. When the type other than "Through" is selected, the circle changes to a yellow circle.

[Operation with a tabular display]
Selecting the type other than "Through" causes the type and Freq. (Hz) (frequency) of the selected filter point to be changed. (If "Variable-Q" is selected, the Q value changes simultaneously.) To cancel, select the filter point to be canceled, and select "Through." Then, the type of the selected filter point changes to "Through."

(7) Frequency display button [Freq. (Hz)]
Frequency of the selected filter point is displayed on the Frequency display button.
A Frequency Setting dialog shown at right is displayed if this button is clicked, enabling you to set the frequency by directly entering a numerical value. (Setting range: 20 to 20000 Hz)
You can also change the frequency with the Up and Down buttons located on the right side.

(8) Q display button [Q]
Q value of the selected filter point is displayed on the Q display button. Click this button to select the setting value from the pull-down menu.

(9) Table display button
Click this button to display the Contents view in tabular form.
Click this button again to revert to the graphical display.
7. Filter
Displays overviews of the filter.
Selecting the Filter box permits the filter to be set in the Contents view.

Number of usable filters
Overview of the set filter characteristics

(1) Filter control area
(2) minimum frequency adjusting button
Increases or decreases the lower frequency limit on a graduated scale.

(10) Scale button
Click this button to display a Scale dialog shown at right. The display scale can be changed when in graphical display mode.

(11) minimum amplitude adjusting button
Increases or decreases the lower amplitude limit on a graduated scale.
(3) Filter point symbol
Select the filter point from the filter point symbols as required. Right-clicking the mouse with the pointer over any point on the filter point symbol or drag and drop the "Unset" filter point symbol (gray circle) in the filter control area causes the pull-down menu for selecting the filter type to appear as shown at right.

Selecting the item other than "Through" displays a circle in the filter control area. To cancel it, right-click the mouse over the filter point symbol again, select "Through," then the circle in the filter control area disappears. A yellow circle represents the selected filter point.

- Parametric equalizer (PEQ)
- High pass filter (HPF)
- Low pass filter (LPF)
- High shelving filter (High Shelving)
- Low shelving filter (Low Shelving)
- All pass filter (All Pass)
- Notch filter (Notch)
- Horn equalizer (Horn EQ)
- Unset filter point symbol (Through)

(4) Filter point

[Graphical display]
Circles in the filter control area are operable filter points. If a smaller yellow circle is displayed at the left side of the filter point when a filter point is selected, by clicking and dragging the yellow circle up and down, the Q value of the selected filter point can be changed.

[Tabular display]
In the tabular display, each line shows the filter point and the "Type" column shows the filter types. The highlighted line is the selected filter point. For the unset filter point, the "Through" indication is displayed in "Type" column.

<table>
<thead>
<tr>
<th>Type</th>
<th>Freq (Hz)</th>
<th>Gain (dB)</th>
<th>Q</th>
<th>On/Off</th>
</tr>
</thead>
<tbody>
<tr>
<td>High Shelving</td>
<td>6.27%</td>
<td>-9.1</td>
<td>--</td>
<td>On</td>
</tr>
<tr>
<td>PEQ</td>
<td>192.8</td>
<td>-10.2</td>
<td>2.2857</td>
<td>On</td>
</tr>
<tr>
<td>Low Shelving</td>
<td>180</td>
<td>8.3</td>
<td>--</td>
<td>Off</td>
</tr>
<tr>
<td>HPF (6 dB)</td>
<td>100</td>
<td>-</td>
<td>--</td>
<td>Off</td>
</tr>
<tr>
<td>LPF (6 dB)</td>
<td>10.0K</td>
<td>-</td>
<td>--</td>
<td>Off</td>
</tr>
<tr>
<td>Through</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>On</td>
</tr>
<tr>
<td>Through</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Off</td>
</tr>
<tr>
<td>Through</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>Off</td>
</tr>
</tbody>
</table>

(5) maximum frequency adjusting button
Increases or decreases the higher frequency limit on a graduated scale.

(6) maximum amplitude adjusting button
Increases or decreases the higher amplitude limit on a graduated scale.
(7) Filter type display button
Filter type of the selected filter point is displayed on the Filter type display button.
If this button is clicked, the same pull-down menu as the one that appears when the mouse is right-clicked over the filter point symbol is displayed, enabling filter type selection.
Selecting "Through" on a graphical display causes a circle of the selected filter point to disappear from the filter control area.
Selecting "Through" on a tabular display changes the type of the selected filter point to "Through" indication.

(8) Frequency display button [Freq. (Hz)]
Frequency of the selected filter point is displayed on the Frequency display button.
A Frequency Setting dialog shown at right appears if this button is clicked, enabling you to set the frequency by directly entering a numerical value. (Setting range differs depending on the filter type.)
You can also change the frequency with the Up and Down buttons located on the right side.

(9) Gain display button [Gain (dB)]
Gain of the selected filter point is displayed on the Gain display button.
A Gain Setting dialog shown at right is displayed if this button is clicked, enabling you to set the gain by directly entering a numerical value. (Setting range differs depending on the filter type.)
You can also change the gain in 0.1 dB units with the Up and Down buttons (changeable to 0.5 dB units with the Option button) located on the right side.

(10) Q display button [Q]
Q value of the selected filter point is displayed on the Q display button.
The setting value can be selected from the pull-down menu if this button is clicked.

(11) Filter ON/OFF button [ON/OFF]
ON/OFF state of the selected filter is displayed on the Filter ON/OFF button. The filter alternates between ON and OFF as this button is clicked.

(12) Table display button
The Contents view is displayed in tabular form if this button is clicked. Clicking this button again reverts to the graphical display.
(13) **Option button**
A pull-down menu shown at right is displayed if this button is clicked.

- **Scale**
  A Scale dialog shown at right is displayed if Scale is selected, enabling you to change the display scale when in graphical display mode.

- **Q-Display**
  Can be displayed only when the filter type with Q value to be set such as PEQ is selected. If such filter type is selected, its Q value can be changed.

- **Fine Resolution**
  A pull-down menu shown at top right is displayed if this menu item is selected.
  To change Step width of the frequency, select "Frequency."
  To change Step width of the gain, select "Gain."

(14) **minimum amplitude adjusting button**
Increases or decreases the lower amplitude limit on a graduated scale.
8. Comp.
Selecting the Comp. box permits the compressor state to be checked and set in the Contents view. ON/OFF of the compressor can be set in this box or in the Contents view.

[Comp. Box]

[Contents view when Comp. box is selected (at Comp. tab selection)]

[Contents view when Comp. box is selected (at Comp. All tab selection)]
The compressor setting values of all the speakers can be displayed and changed.

(1) Com. ON/OFF button [On/Off]
ON/OFF state of the compressor is displayed on the Com. ON/OFF button. The compressor alternates between ON and OFF as this button is clicked.
(2) **Input/output level meter**  
Peak and RMS values for input/output signal level, reduction level (or attenuated level by the compressor), and threshold level are indicated with bar graphs as shown below.

(3) **mode switching button [Comp]**  
Compressor mode is displayed on the Mode switching button. A pull-down menu shown at right is displayed if this button is clicked. Compressor mode can be changed from the pull-down menu.

(4) **Threshold button [Threshold (dB)]**  
Compression threshold level is displayed on the Threshold button. A Threshold Setting dialog shown at right appears if this button is clicked, enabling you to set the level by directly entering a numerical value. (Setting range: −20 to +20 dB) You can also change the level in 1 dB units with the Up and Down buttons located on the right side.

(5) **Ratio button [Ratio]**  
Compression ratio is displayed on the Ratio button. The setting value can be selected from a pull-down menu if this button is clicked. You can also change the ratio with the Up and Down buttons located on the right side.

(6) **knee type button [knee Type]**  
Compression knee type is displayed on the Knee type button. The setting value can be selected from a pull-down menu if this button is clicked. You can also change the setting value with the Up and Down buttons located on the right side. There are 3 setting options: Hard, Soft 1, and Soft 2.  
Hard: Called "Hard knee characteristics," this compresses the signal level immediately when its level exceeds a set threshold.  
Soft 1/Soft 2: Compresses the signal level gradually before it reaches the threshold, and the compression ratio gradually varies and slowly approaches the set ratio until the signal level exceeds the threshold to a certain extent. If the level exceeds the threshold to a large degree, this compression type shows the Hard knee characteristics. Soft 2 provides gentler characteristics than Soft 1.

(7) **Attack time button [Attack (ms)]**  
Compressor attack time is displayed on the Attack time button. The setting value can be selected from a pull-down menu if this button is clicked. You can also change the setting value with the Up and Down buttons located on the right side.
(8) **Release time button [Release (ms)]**
Compressor release time is displayed on the Release time button. The setting value can be selected from a pull-down menu if this button is clicked. You can also change the setting value with the Up and Down buttons located on the right side.

(9) **Gain button [Gain (dB)]**
Compressor gain is displayed on the Gain button. A Gain Setting dialog shown at right is displayed if this button is clicked, enabling you to set the gain by directly entering a numerical value. (Setting range: \(-\infty, -69\) to +10 dB)
You can also change the gain in 1 dB units with the Up and Down buttons located on the right side.

9. **Output meter**
Displays the output level. Selecting the box displays the output level of the speaker in the Stack in the Contents view.

[Contents view when Output meter is selected]
10. Delay
The Delay view is displayed in the Contents view by selecting the Delay box, enabling you to set Delay. ON/OFF of the Delay can be performed on the Delay box or in the Delay view.

[Delay box]

(1) Delay ON/OFF button [On/Off]
ON/OFF state of the delay function is displayed on the Delay ON/OFF button. This function alternates between ON and OFF as this button is clicked.

(2) Delay time display
Displays the delay time at the speaker.

(3) Delay time display button [Time (ms)]
Delay time at the speaker is displayed on the Delay time display button. A Delay dialog shown at right appears if this button is clicked, enabling you to set the delay time by directly entering a numerical value. (Setting range: 0 to 682.646 ms) If the delay time is set, the delay distance is automatically calculated, changing its display on the Delay distance display button (6).

(4) minimum variation unit selection button
Select the minimum units of the delay time changeable with the Up and Down buttons (7).
(5) **Option button**
A Delay Option dialog shown at right appears if this button is clicked, enabling you to select the units of distance to be displayed on the Delay distance display button (6) from meters, inches, and feet. You can also set the temperature in either Centigrade or Fahrenheit used for calculating the distance to be displayed on the Delay distance display button.

**Tip**
Changing the units of distance in the Delay Option dialog causes the units of distance (meters, inches, or feet) on the Delay distance display button and in the Delay distance setting dialog to change simultaneously.

(6) **Delay distance display button [Distance (meters/inches/feet)]**
Delay distance at the speaker is displayed on the Delay distance display button.
A Delay dialog shown at right appears if this button is clicked, enabling you to set the delay distance by directly entering a numerical value. (Setting range: 0 to 235.042 meters, 0 to 8866.0 inches, or 0 to 740.66 feet)
If the delay distance is set, the delay time is automatically calculated, changing its display on the Delay time display button (3).

(7) **Up and Down buttons**
Change the delay time in minimum variation units. Delay distance is calculated automatically based on this change.
7.4. Settings in the mixer view

Clicking the Mixer tab in the Operation view displays the Mixer view. Displays the signal processing image consisting of the signal processing functional boxes and Input-to-Mix Out signal flow via Matrix for each Stack.

7.4.1. Operation

- Selecting each box other than Input and Mix Out boxes displays its detailed information in the Contents view.
- Right-clicking the mouse with the pointer over Automix, Fader, Matrix, or Mix Out Fader box displays the Context menu as shown below.

- **Copy**
  Copies the setting value of the designated (right-clicked) box to the clipboard.

- **Paste**
  Pastes the setting value of the clipboard to the designated (right-clicked) box.
  Tip
  "Paste" is active only when you right-click on the box of the same type as the box to which copy has been performed.

- **Clear**
  Initializes the setting value of the designated (right-clicked) box.

- You can also copy the parameters between boxes of the same type in the Mixer view by dragging and dropping the box to another speaker's box of the same type.
7.4.2. mixer view's part description and settings in the Contents view

1. Stack name
   Displays the Stack name.

2. Input
   Indicates the input channel.

3. meter
   Displays the input level.
   Selecting the box displays the input level at each input channel in the Contents view.

   [Contents view when meter box is selected]
   In the figure below, input signal is applied only to the Analog 1 and Analog 2, but no input signal is applied to CobraNet inputs 1 through 4.
4. Automix
The Automix box contains the Gate ON/OFF button and Gate status indicator.

[Automix box (Gate ON, gate operating)]

(1) Gate ON/OFF button [Gate On/Off]
ON/OFF state of the gate function is displayed on the Gate ON/OFF button. This function alternates between ON and OFF as this button is clicked.

(2) Gate status indicator
Lights yellow when the gate operates (closes).

[Automix box (Gate OFF, gate not operating)]

[Contents view when Automix box is selected (at Gate tab selection)]

[Contents view when Automix box is selected (at Gate All tab selection)]
Displays setting values of all input channels, and performs setting change.

(1) Gate ON/OFF button [Gate On/Off]
ON/OFF state of the gate function is displayed on the Gate ON/OFF button. This function alternates between ON and OFF as this button is clicked.

(2) Gate status indicator
Lights yellow when the gate operates (closes).
(3) **Input/Output level meter**
Displays the input/output signal level with a bar graph.

(4) **Voice filter ON/OFF button [Voice On/Off]**
The level passed through the A-weighted filter can be detected if this button is clicked.

(5) **Gate threshold button [Gate Threshold (dB)]**
Gate threshold level is displayed on the Gate threshold button.
A Threshold Setting dialog shown at right appears if this button is clicked, enabling you to set the threshold by directly entering a numerical value.
(Setting range: −50 to +20 dB)
You can also change the level in 1 dB units with the Up and Down buttons located on the right side.

(6) **Gate hysteresis button [Gate Hysteresis (dB)]**
Gate hysteresis is displayed on the Gate hysteresis button.
A Hysteresis Setting dialog shown at right appears if this button is clicked, enabling you to set the hysteresis by directly entering a numerical value.
(Setting range: 0 to +10 dB)
You can also change the gate hysteresis in 1 dB units with the Up and Down buttons located on the right side.

(7) **Gate depth button [Gate Depth (dB)]**
Gate depth is displayed on the Gate depth button.
A Depth Setting dialog shown at right appears if this button is clicked, enabling you to set the depth by directly entering a numerical value.
(Setting range: −∞, −69 to 0 dB)
You can also change the gate depth in 1 dB units with the Up and Down buttons located on the right side.

(8) **Gate hold time button [Gate Hold (ms)]**
Gate hold time is displayed on the Gate hold time button. The setting can be selected from a pull-down menu if this button is clicked. You can also change the gate hold time with the Up and Down buttons located on the right side.

(9) **Gate attack time button [Gate Attack (ms)]**
Gate attack time is displayed on the Gate attack time button. The setting can be selected from a pull-down menu if this button is clicked. You can also change the gate attack time with the Up and Down buttons located on the right side.

(10) **Gate release time button [Gate Release (ms)]**
Gate release time is displayed on the Gate release time button. The setting can be selected from a pull-down menu if this button is clicked. You can also change the gate release time with the Up and Down buttons located on the right side.
Contents view when Automix box is selected (at Ducker tab selection)
Displays ducker settings of all input channels, and performs setting change.

11) Ducker priority level button [Ducker priority level]
Priority order is displayed on the Ducker priority level button.
(1 through 3, 1: Highest level, 3: Lowest level)
A Priority Level Setting dialog shown at right appears if this button is clicked, enabling you to set the priority level by directly entering a numerical value. You can also change the priority level with the Up and Down buttons located on the right side.

12) Ducker depth button [Ducker Depth (dB)]
Ducker depth is displayed on the Ducker depth button.
A Depth Setting dialog shown at right appears if this button is clicked, enabling you to set the ducker depth by directly entering a numerical value.
(Setting range: $-\infty$, −69 to 0 dB)
You can also change the ducker depth in 1 dB units with the Up and Down buttons located on the right side.

13) Ducker attack time button [Ducker Attack (ms)]
Ducker attack time is displayed on the Ducker attack time button. The setting can be selected from a pull-down menu if this button is clicked. You can also change the ducker attack time with the Up and Down buttons located on the right side.

14) Ducker release time button [Ducker Release (ms)]
Ducker release time is displayed on the Ducker release time button. The setting can be selected from a pull-down menu if this button is clicked. You can also change the ducker release time with the Up and Down buttons located on the right side.

15) Ducker ON/OFF button [Ducker On/Off]
ON/OFF state of the Ducker function is displayed on the Ducker ON/OFF button. The Ducker function alternates between ON and OFF as this button is clicked.
5. Fader
Adjusts the level at each input channel connecting to the Matrix. The Fader box contains the Channel ON/OFF button and Gain display button.

[Fader box (Channel: ON, Gain: 2.0 dB)]

[Fader box (Channel: OFF, Gain: 0 dB)]

[Contents view when Fader box is selected]

(1) Channel ON/OFF button [On/Off]
ON/OFF state of each channel is displayed on the Channel ON/OFF button. The channel alternates between ON and OFF as this button is clicked.

(2) Gain display [Fader (dB)]
Level at each channel is displayed on the Gain display. You can change the gain in 0.1 dB units with the Up and Down buttons located on the right side in the Fader box.
A Fader Setting dialog shown at right appears if this button is clicked in the Fader view, enabling you to set the gain by directly entering a numerical value. (Setting range: $-\infty$, −69.9 to +10.0 dB)
You can change the gain in 0.1 dB units with the Up and Down buttons located on the right side.

(3) Level meter display
Displays the input level with the meter.
Tip: The meter shows a peak level.

(4) Fader
You can change the level at each channel by moving this fader up and down.
Double-clicking the fader box while holding down the PC’s Ctrl key changes the fader value to 0 dB.
6. matrix
A function box for routing from the Analog inputs 1 and 2 and CobraNet inputs 1 through 4 to the Mixer outputs 1 and 2. In the Contents view, each input channel can be assigned to Mix Outs 1 and 2 by turning on or off the Cross point.

[Contents view when matrix box is selected]

(1) Input channel display
Displays Analog inputs 1 and 2, and CobraNet inputs 1 through 4.

(2) mixer output channel display
Displays Mixer output 1 and Mixer output 2.

(3) Assignment ON/OFF button
A button to turn ON and OFF the assignment.
Clicking on the cross point between the input on the Input channel display (1) and the output on the Mixer output channel display (2) allows the input channel and the output channel to be assigned (ON/OFF). ON and OFF state alternates with the click operation.
In the example of the figure above, assignments have been made as follows.
• Analog In 1, CobraNet In 1, and CobraNet In 2 channels are assigned to Mix Out 1.
• Analog In 2, CobraNet In 1, and CobraNet In 2 channels are assigned to Mix Out 2.
The ON/OFF state set in the Contents view is simultaneously displayed in the Matrix box in the Operation view.
7. mix Out Fader
Adjusts the level at each output channel. The Mix Out Fader box contains the Channel ON/OFF button and Gain display button.

- **Channel ON/OFF button [On/Off]**
  ON/OFF state of each channel is displayed on the Channel ON/OFF button. The channel alternates between ON and OFF as this button is clicked.

- **Gain display [Fader (dB)]**
  Level at each channel is displayed on the Gain display. You can change the gain in 0.1 dB units with the Up and Down buttons located on the right side in the Fader box.
  A Fader Setting dialog shown at right appears if this button is clicked in the Fader view, enabling you to set the gain by directly entering a numerical value. (Setting range: $-\infty$, -69.9 to +10.0 dB) You can change the gain in 0.1 dB units with the Up and Down buttons located on the right side.

- **Fader**
  You can change the level at each channel by moving this fader up and down. Double-clicking the fader box while holding down the PC’s Ctrl key changes the fader value to 0 dB.

- **Level meter display**
  Displays the output level with the meter.
  **Tip:** The meter shows a peak level.
8. **mix Out meter**
   Displays the output level at each output channel in the Contents view by selecting this box.

![Contents view when mix Out meter is selected]

9. **Output**
   Indicates the output channel.
7.5. Settings in the Beam Steering view

The Beam Steering view is displayed by selecting the Beam steering tab in the Operation view. In the Beam Steering view, it is possible to set parameters for speaker installation position, beam angle, beam width, and audience position and to control vertical directivity angle of the beam radiated from the speaker (Beam steering).

In the Beam Steering Simulation view, the beam simulation result can be visually checked, which has been performed based on the parameters set in the Beam Steering view. Besides, the sound pressure to the audience can be displayed graphically in the Beam Steering Graph view.

If the Audience setting has been made, the optimum beam steering value can also be automatically calculated.

7.5.1. part description and settings in the Beam Steering view

Tip
Selecting [Option → Beam Steering Parameter Setting] from the menu allows a unit of distance to be changed to meters or feet.
**[Speaker Setting]**

1. **position (X)**
   Sets speaker's installation position (X). You can set the position by directly entering a numerical value. (Setting range: 0.00 m to 200.00 m)
   You can also change the position in 0.5 m units with the Up and Down buttons located on the right side.

2. **position (Y)**
   Sets speaker's installation position (Y). You can set the position by directly entering a numerical value. (Setting range: 0.00 m to 200.00 m)
   You can also change the position in 0.5 m units with the Up and Down buttons located on the right side.

3. **Setting Origin**
   Sets origin of speaker installation. Origin of installation can be selected from “Front upper side,” “Front lower side,” “Rear lower side,” or “Rear upper side.”

4. **Setting Angle**
   Sets installation angle of the speaker. You can set the angle by directly entering a numerical value. (Setting range: −30° to 30°)
   You can also change the angle in 1° units with the Up and Down buttons located on the right side.

**[Steering Setting]**

1. **Beam Angle**
   Sets the first beam angle. (For beam angle, see p. 105.)
   You can set the angle by directly entering a numerical value. (Setting range: −45° to 45°, note that this angle must be equal or larger than the second beam angle if the second beam is effective.)
   You can also change the width in 1° units with the Up and Down buttons located on the right side.

2. **Beam Width**
   Sets the first beam width. (For beam width, see p. 105.)
   You can set the width by directly entering a numerical value. (Setting range: 0° to 45°)
   You can also change the width in 1° units with the Up and Down buttons located on the right side.

3. **Divide Beam**
   Sets whether to split the beam into 2 beams. The beam split becomes valid by checking the box, enabling you to set the second beam angle and width. When the box is unchecked, the beam split is inactive.

4. **Second Beam Angle**
   Sets the second beam angle. You can set the angle by directly entering a numerical value. (Setting range: −45° to 45°, note that the first angle must be equal or larger than this second beam angle.)
   You can also change the angle in 1° units with the Up and Down buttons located on the right side.

5. **Second Beam Width**
   Sets the second beam width. You can set the width by directly entering a numerical value. (Setting range: 0° to 45°)
   You can also change the width in 1° units with the Up and Down buttons located on the right side.
[Space Setting]

1. Space Depth (X direction)
Sets the depth in the fore direction of the speaker (Stack) in the space (location) where the speaker (Stack) is installed. You can set the depth by directly entering a numerical value. (Setting range: 10 m to 200 m)
You can also change the depth in 1 m units with the Up and Down buttons located on the right side.

[Audience Setting]

1. Audience 1 active/inactive setting
Sets whether the Audience 1 is active or inactive. Audience 1 is active by checking the box, allowing you to set the start position and end position. When the box is unchecked, Audience 1 is inactive.

2. Audience 2 active/inactive setting
Sets whether the Audience 2 is active or inactive. Audience 2 is active by checking the box, allowing you to set the start position and end position. When the box is unchecked, Audience 2 is inactive.

3. Front (X)
Sets the start position (X) of the Audience 1 or Audience 2. You can set the position by directly entering a numerical value. (Setting range: 0 m to 200.0 m)
You can also change the position in 0.5 m units with the Up and Down buttons located on the right side.

4. Front (Y)
Sets the start position (Y) of the Audience 1 or Audience 2. You can set the position by directly entering a numerical value. (Setting range: 0 m to 200.0 m)
You can also change the position in 0.5 m units with the Up and Down buttons located on the right side.

5. Back (X)
Sets the end position (X) of the Audience 1 or Audience 2. You can set the position by directly entering a numerical value. (Setting range: 0 m to 200.0 m)
You can also change the position in 0.5 m units with the Up and Down buttons located on the right side.

6. Back (Y)
Sets the end position (Y) of the Audience 1 or Audience 2. You can set the position by directly entering a numerical value. (Setting range: 0 m to 200.0 m)
You can also change the position in 0.5 m units with the Up and Down buttons located on the right side.

7. Calculate Steering button
Becomes active when the Audience 1 or Audience 2 is active. Clicking this button permits each parameter of steering setting to be automatically calculated remaining the parameters of speaker setting, space setting, and audience setting unchanged so that the beam can be appropriately delivered to the set audience. See “Calculating the Beam steering automatically” on p. 50 for details.
7.5.2. Contents view display (at Beam Steering Simulation tab selection)

The Beam Steering Simulation view indicates the Speaker, Audience, and Beam based on each parameter set in the Beam Steering view. It is also possible to perform Steering simulation and graphically display the simulation result by means of the sound pressure distribution. Each parameter set in the Beam Steering view can be transmitted to the speaker by applying the Steering simulation result with the [Apply] button.

1. **Speaker**
   Indicates the speaker. Position, Setting Origin, and Setting Angle set in the Speaker setting in the Beam Steering view are reflected to the displayed speaker.

2. **Frequency**
   Selects sound frequency used for simulation from the pull-down menu. (Setting range: 4000 Hz, 2000 Hz, 1000 Hz, and 500 Hz)
3. Simulation button
A dialog as shown below appears if this button is clicked, performing vertical directivity angle simulation (Beam Steering simulation) based on each parameter in the Beam Steering view.

Simulation result is displayed by way of the sound pressure distribution image as shown below when the vertical directivity angle simulation (Beam Steering simulation) is complete.

Tip
Simulation result is cancelled by clicking the [Trash] button after the vertical directivity angle simulation (Beam Steering simulation) is complete.

4. Apply button
Each parameter is transmitted to the speaker if this button is clicked. This button becomes active when the Beam Steering simulation is complete, while it becomes inactive when the simulation result is cleared after each parameter has been changed.

Note
Though each parameter is transmitted to the speaker by clicking this button, it is lost without being saved when the power is turned OFF. When each parameter needs to be stored, be sure to store it to a Preset memory.

Tip
Performing Preset memory store and Project save after clicking this button permits the simulation result to be stored as a file (Beam Steering Simulation file). This file can be automatically read by the SR-D8 PC software to reproduce the simulation result at a high speed when the frequency or preset memory is changed. However, the file data cannot be viewed on an image display software.

For the file storage location and its control method, see "Project files description" in the "Project Management" (p. 74).

5. Trash button
Reverts the parameters in the Beam Steering view and the Speaker display, Audience setting, beam setting, and simulation result in the Beam Steering Simulation view to the settings saved in the current Preset memory if this button is clicked. This button becomes active when each parameter in the Beam Steering view is entered or changed. Clicking the [Apply] or [Trash] button makes the [Trash] button inactive.
6. **Spl Range Setting: max.**
   The maximum level of the sound pressure level (SPL) range of the simulation result can be changed. You can set the level by directly entering a numerical value. (Setting range: 50 to 150 [dB])
   You can also change the level in 1 [dB] units with the Up and Down buttons located on the right side.

7. **Spl Range Setting: volume**
   Volume of the SPL range of the simulation result can be changed. You can set the volume by directly entering a numerical value. (Setting range: 30 to 100 [dB])
   You can also change the volume in 1 [dB] units with the Up and Down buttons located on the right side.

8. **Audience 1 or Audience 2**
   Refers to the Audience 1 or Audience 2 assigned in the Audience setting in the Beam Steering view.

9. **Beam**
   Refers to the Beam axis assigned in the Steering setting in the Beam Steering view.

10. **Height scale of the space**
    Indicates height of the space in m (meter/feet).
    **Tip**
    Though the height setting of the space cannot be performed directly, it changes automatically as the depth (X direction) of the space in the Space setting in the Beam Steering view is changed.

11. **Depth scale of the space**
    Indicates depth of the space in m (meter/feet). This scale automatically moves as depth (X direction) of the space in the Space setting in the Beam Steering view is changed.

12. **Sound pressure color mapping and scale**
    Indicates the sound pressure color mapping of the simulation result. This is interlocked with Item "Spl Range Setting: Max." (6) and Item "Spl Range Setting: Volume" (7).
7.5.3. Contents view display (at Beam Steering Graph tab selection)

The Beam Steering Simulation view graphically displays the sound pressure distribution to the audience after Beam Steering Simulation has been performed in the Beam Steering Simulation view.

This chart is not displayed when the Audience setting is not performed in the Beam Steering view or the Beam Steering simulation is incomplete. Displayed graph changes automatically when the Audience setting in the Beam Steering view is changed.

1. Frequency pull-down menu
   Selects the frequency of which characteristics graph is displayed from a pull-down menu.
   (Setting range: 4000 Hz, 2000 Hz, 1000 Hz, and 500 Hz)

2. Sound pressure distribution graph (Audience 1)
   Graphically displays the sound pressure distribution to the Audience 1. This is not displayed when the simulation is incomplete or Audience 1 setting is not performed.

3. Sound pressure distribution graph (Audience 2)
   Graphically displays the sound pressure distribution to the Audience 2. This is not displayed when the simulation is incomplete or Audience 2 setting is not performed.

4. Sound pressure scale
   Indicates the sound pressure level to the Audience.

5. Length scale
   Indicates length of the Audience in m (meter/feet).
   Tip: Each Audience starting point is 0.
7.5.4. Calculating the Beam steering automatically

In the Beam Steering view, when the Audience Setting is active, clicking the [Calculate Steering] button sets each parameter of the Steering Setting by automatically calculating each parameter of Speaker Setting and Audience Setting so that the beam can properly direct to the set Audience.

[Before Beam Steering automatic calculation]
The state before calculation is assumed as shown below.

[After Beam Steering automatic calculation]
In the "Before Beam Steering automatic calculation" state, Beam angle and Beam width are automatically calculated and set as shown below so that the beam can be properly directed to the Audience when the [Calculate Steering] button for Audience Setting in the Beam Steering view is clicked.
[When Beam Steering automatic calculation results in error]

Automatic calculation of the beam steering may result in error as shown below depending on the positional relationship between the Speaker and Audience.

When the automatic calculation of the Beam steering results in error, the Error dialog appears as shown below.

![Error dialog](image)

Click the [OK] button, and readjust the Speaker and Audience settings.

- **In case the length of Audience is 0:**
  When both the start and end positions of the Audience setting for the enabled Audience are equal, then the length of Audience is 0, resulting in error.

- **In case the start position of the Audience setting is located posterior to the speaker position:**
  As the Audience position is located posterior to the speaker position, the beam cannot be directed to the Audience.

![Audience setting](image)

- **In case the beam angle is beyond the range between −45° and 45° as a result of automatic calculation of Beam steering:**
  The range the automatic calculation covers is between −45° and 45°. The automatic calculation cannot be performed beyond the range as the angle is too sharp.

![Beam steering angle](image)

- **In case the beam width is over 45° as a result of automatic calculation of Beam steering:**
  Maximum width the automatic calculation covers is 45°. The automatic calculation cannot be performed beyond the limit.

![Beam steering width](image)
• In case the beam angle becomes the angle at which beam is directed upward to the Audience floor as a result of automatic calculation of Beam steering:
As this beam does not reach the Audience, the calculated result is invalid.

![Image of Beam Steering View]

• In case the beam angle becomes the angle at which the beams will cross as a result of automatic calculation of Beam Steering:
Though beams are not crossing in the image below, when the Audience setting is made as shown in the image below, the first beam angle should be smaller than the second one (beams cross) in order to target each Audience, resulting in error.

![Image of Beam Steering View with Beams Crossing]

[Context menu]
Right-clicking the mouse with the pointer over the Beam Steering view or the Contents view causes the following context menu to be displayed.

- **Beam Steering Parameter Copy**
  Copies the selected Stack's Beam Steering parameters into memory.
- **Beam Steering Parameter Paste**
  Pastes the Stack's Beam Steering parameters that have been copied into memory to the selected Stack.
7.6. Status view Display and Operation

Selecting the speaker expanded in the System tree view displays the speaker status in the Main view, which is referred to as "Status view."

In the Status view, complete details about the speaker can be confirmed.

7.6.1. part description of the Status view and operation
1. **Stack name and Speaker name**
   Displays the selected speaker’s Stack name and speaker name. Displays in [Stack name - > Speaker name] form.

2. **Status indicator button**
   Toggles the Status indicator of the selected speaker between ON and OFF.
   - Status indicator OFF
   - Status indicator ON
   - Offline

3. **Temperature indication clear button**
   Clears the State retention mark of the temperature indication.

4. **Current state clear button**
   Clears the State retention mark of the electric current state.

5. **Limiter clear button**
   Clears the State retention mark of the protection limiter.

6. **Temperature indication**
   Indicates the temperature state inside the selected speaker. When error in temperature occurs, the State retention mark appears at the upper right of the temperature indicator and lights to indicate that error in temperature has occurred. The State retention mark can be cleared by clicking the Temperature indication clear button (3).
   - Normal state
   - Normal state (with a State retention mark)
   - High-temperature state (with a State retention mark)
   - Offline

7. **Current state**
   Indicates the selected speaker’s electric current state. When abnormality in current state occurs, the State retention mark appears at the upper right of the current state and lights to indicate that error in current has occurred. The State retention mark can be cleared by clicking the Current state clear button.
   - Normal state
   - Normal state (with a Status retention mark)
   - Abnormal current state (with a Status retention mark)
   - Offline state

8. **Output level**
   Displays the output level of each speaker module with the meter.

9. **Protection limiter state**
   Displays the operation state of the protection limiter in red. Once the protection limiter has worked, the State retention mark continues to appear until the Limiter clear button (5) is clicked.
   - Normal mode
   - Normal mode (with a State retention mark)
   - Protection limiter operating (with a State retention mark)
   - Offline

10. **Speaker module mute**
    Each speaker module mute toggles ON and OFF as it is double-clicked. Also it displays the speaker module mute state.
    - Normal state (Mute OFF)
    - Mute ON
    - Offline
8. MUTE All View

8.1. Mute All View Show/Hide Button

The Mute All View button permits simultaneous mute control of all Stacks’ speaker outputs, and is only operational while online. The Mute All View button's status is not retained in the project.

The Mute All View button can be set to Show or Hide by clicking on [View → Mute All Show/Hide] on the menu.

The floating Mute All View button can be moved to any location on the screen by dragging it with the mouse.

[mute All view button display example]

8.2. Mute All ON/OFF Switching

Clicking the Mute All View button toggles the Mute All function between ON and OFF.

[Mute All View (OFF)]

Status toggles when clicked on.

[Mute All View (ON)]

All speakers are muted regardless of individual speaker mute settings.
### 8.3. mute Summary

<table>
<thead>
<tr>
<th>Mute Type</th>
<th>Description</th>
<th>Storage in Preset Memory</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute All</td>
<td>Muting for all online Stacks' speakers can be simultaneously switched ON or OFF.</td>
<td>×*</td>
<td>P. 55</td>
</tr>
<tr>
<td>Stack Mute</td>
<td>The Mute function is enabled or disabled for selected stacks.</td>
<td>×*</td>
<td>P. 15</td>
</tr>
<tr>
<td>Speaker Mute</td>
<td>The Mute function is enabled or disabled for selected speakers.</td>
<td>×*</td>
<td>P. 17</td>
</tr>
<tr>
<td>Speaker Module Mute</td>
<td>The Mute function is enabled or disabled for selected speakers' built-in speaker modules.</td>
<td>×*</td>
<td>P. 54</td>
</tr>
<tr>
<td>Preset Mute</td>
<td>The Mute function is enabled or disabled by the Mute setting in the selected speaker's DSP view.</td>
<td>✓</td>
<td>P. 22</td>
</tr>
</tbody>
</table>

**Note:** When the speakers and a PC are online, the PC can send the mute state to the speakers in real time and such mute state can be retained in the speaker. Status data is retained in the speakers and the mute status is displayed on the SR-D8 PC Software, unless speaker power is switched OFF or the Mute function is enabled/disabled with the SR-D8 PC Software again.
9. COBRANET ROUTING SETTING

CobraNet Transmit bundle and Receive bundle can be performed in the CobraNet routing view. CobraNet routing view is displayed in the Main view if the [CobraNet Routing] button is clicked in the System configuration view.

9.1. CobraNet Routing Setting mode

Two modes are made available in CobraNet routing view: Normal mode and Advanced mode. Toggle the mode as needed.

Normal mode:

Performs the default CobraNet routing setting for each Project that is independent of the Preset memory. The bundles set in the Edit Rx Bundle dialog and Edit Tx Bundle dialog can be assigned to the Stack with the ON/OFF button. In Normal mode, only a single Receive bundle can be assigned to the Stack. Channels are fixed to CH 1 through 4.

Advanced mode:

A more detailed setting than the Normal mode setting can be performed. Arbitrary Receive bundle and channel can be assigned to the Stack. In Advanced mode, setting can be performed in Preset memory units.
9.2. Screen Description and Settings When in Normal mode

1. Edit Rx Bundle button
   The Edit Rx Bundle dialog appears if this button is clicked, enabling you to edit the Receive bundle. The setting contents is displayed in Receive bundle list (5).

   **Note**
   Setting duplicated Unicast bundle numbers to the multiple Receive bundles as shown below causes audio data not to be received correctly from the CobraNet. Take care not to enter the same Unicast number in the Bundle number fields.

   **Tips**
   - Up to 16 characters can be used for the bundle name.
   - The [OK] button is inactive used if the bundle name already exists or if the bundle name is blank.
   - Set the bundle number to 0 or 1 – 65279. 0 is used to indicated a bundle for which no bundle settings are performed.
   - Receive bundle editing can also be performed through menu operation. (See p. 11.)
2. Edit Tx Bundle
The Edit Tx Bundle dialog appears if this button is clicked, enabling you to edit the Transmit bundle. The setting contents are displayed in Stack Transmit bundle list (4).

[Edit Tx Bundle dialog]

Tips
- Set the bundle number to 0 or 1 – 65279. 0 is used to indicated a bundle for which no bundle settings are performed.
- Select the output contents (Output Selector) from the pull-down menu as shown below:

<table>
<thead>
<tr>
<th>Tips</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Set the bundle number to 0 or 1 – 65279. 0 is used to indicated a bundle for which no bundle settings are performed.</td>
</tr>
<tr>
<td>- Select the output contents (Output Selector) from the pull-down menu as shown below:</td>
</tr>
</tbody>
</table>

The pull-down menu items of the Output selector are as follows.

<table>
<thead>
<tr>
<th>Output Selector</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute</td>
<td>Outputs no sound.</td>
</tr>
<tr>
<td>Mix Out (Delay OFF)</td>
<td>Outputs Mixer’s Mix Out signals.</td>
</tr>
<tr>
<td>Analog In (Delay OFF)</td>
<td>Outputs Analog In signals.</td>
</tr>
<tr>
<td>Mix Out (Delay ON)</td>
<td>Outputs Mixer’s Mix Out signals, turning on the System Link Delay.</td>
</tr>
<tr>
<td>Analog In (Delay ON)</td>
<td>Outputs Analog In signals, turning on the System Link Delay.</td>
</tr>
</tbody>
</table>

Note: For System Link Delay, see p. 101.

3. Normal/Advanced mode selection button
Toggles the setting mode between Normal mode and Advanced mode.
4. Transmit bundle list
Displays the Stack name of the set Stack and Bundle number of the Transmit bundle from the Stack for up to 4 Stacks. Field frame color of the Bundle number changes depending on the set number. When Multicast bundle is selected, the color changes to pink. When Unicast bundle is selected, it changes to orange.

5. Receive bundle list
Displays 8 Receive bundle numbers and Receive bundle names set in the Receive bundle edit dialog. Field frame color of the Bundle number changes depending on the set number. When Multicast bundle is selected, the color changes to pink. When Unicast bundle is selected, it changes to orange.

6. Stack Receive bundle setting state
Displays the Stack name and Receive bundle number being currently assigned (routed) in the Stack.
7. Routing setting area
Routing can be assigned to each Stack from the Transmit bundle list (4) and the Receive bundle (5). Click the intersection point between the bundles to be assigned for each Stack’s Receive bundle to turn it ON.

Intersection point button set to ON (assigned state)
Intersection point button set to OFF (non-assigned state)

Stack (1) Transmit bundle (Bundle No. 200) and Stack (2) Transmit bundle (Bundle No. 5000) are not assigned as Stack input.

Note
For the Unicast bundle, be sure to make only 1 transmitting destination assigned.
If multiple Stacks have been assigned to the Unicast bundle as shown below, audio data cannot be received correctly from the CobraNet. (When assigning to multiple Stacks, set the Receive bundle number for the Multicast bundle.)
9.3. Screen Description and Settings When in Advanced mode

1. Stack selection tab
   Selects the Stack where the Cobranet routing setting is performed.

2. Normal/Advanced mode selection button
   Toggles the setting mode between Normal mode and Advanced mode.

   Notes
   • After CobraNet routing setting has been changed in Advanced mode, clicking this button to change the
     mode to Normal causes the contents changed in Advanced mode to be initialized and lost.
   • If mode is changed to Normal by accidentally clicking this button in Advanced mode, it is possible to return
     the settings to the contents previously stored by performing "Trash" without performing "Store" into Preset
     memory. In this case, however, the CobraNet routing settings and other parameters return to those saved
     in Preset memory.

3. Receive bundle box
   A box used to set Receive bundle to the Stack being selected with the Stack selection tab.
   Directly enter an Receive bundle number in the Bundle number field.
   (Setting range: 0, 1 through 65279)

   Field frame color of the Bundle number changes depending on the set number.
   When Multicast bundle is selected, the color changes to pink. When Unicast bundle is selected, it changes
   to orange.

   Pink frame: Multicast bundle
   Orange frame: Unicast bundle

   The Select Channel dialog appears as shown on the next page if the area other than Bundle number field of
   this box is clicked.
In the Select Channel dialog, arbitrary Receive bundle channel can be assigned to Inputs 1 through 4. Click the intersection point between each input and the channel to be assigned to turn it on.

4. Transmit bundle box
A box used to set Transmit bundle from the Stack selected with the Stack selection tab.
Set the bundle number by directly entering a Transmit bundle number in the Bundle number field. (Setting range: 0, 1 through 65279)

Field frame color of the Bundle number changes depending on the set number in the same manner as the Receive bundle box. When Multicast bundle is selected, the color changes to pink. When Unicast bundle is selected, it changes to orange. The image of field frame color change is the same as that of Receive bundle box (3).

5. Output Selector
Selects the CobraNet output contents from the Stack.

<table>
<thead>
<tr>
<th>Mute</th>
<th>Outputs no sound.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mix Out (Delay OFF)</td>
<td>Outputs Mixer’s Mix Out signals.</td>
</tr>
<tr>
<td>Analog In (Delay OFF)</td>
<td>Outputs Analog In signals.</td>
</tr>
<tr>
<td>Mix Out (Delay ON)</td>
<td>Outputs Mixer’s Mix Out signals, turning on the System Link Delay.</td>
</tr>
<tr>
<td>Analog In (Delay ON)</td>
<td>Outputs Analog In signals, turning on the System Link Delay.</td>
</tr>
</tbody>
</table>

**Note:** For System Link Delay, see p. 101.
9.4. CobraNet parameter Settings

In CobraNet, audio data is input and output in bundles. The SR-D8 processes bundles of a 48 kHz sampling frequency, 8 channels per Receive bundle and 2 channels per Transmit bundle. When connecting the SR-D8 unit to other CobraNet equipment, latency settings must be matched among all units. Perform CobraNet Parameter settings as needed.

**Step 1.** Select [Option → CobraNet Parameter Setting] from the menu.

The following CobraNet Parameter Setting dialog is displayed:

**Step 2.** Set CobraNet Parameters.

- **Bit Length and Latency**
  Select bit length and latency by clicking on the radio button. Set an intersection point between bit length point and latency to ON.

- **Conductor Priority**
  Set priority that allows the stack to be a conductor. (Setting range: 0 – 128) The larger the value, the higher the priority. Selecting 0 abandons the conductor priority setting.

**Step 3.** Click the [OK] button.
10. GROUp SETTING

The following signal processing functions of each speaker in the DSP view can be assigned to Group setting and Group reset.

When a group setting has been performed, changing one of the parameters (setting value, On/Off, or fader) causes the same signal processing of other speakers assigned the same group to be also changed in synchronization.

Grouping setting view appears in the Main view by clicking the [Grouping Setting] button in the System configuration view.

Note
All the speakers in a Stack are grouped with the same group number by default. If any speaker in the Stack is set to a different group, a wide difference may be seen in the Beam Steering simulation result.

10.1. Nomenclature of the Grouping Setting view

1. Stack name
2. Speaker name
3. mute Group setting button
4. Gain Group setting button
5. LPF/HPF Group setting button
6. Filter Group setting button
7. Comp. Group setting button
8. Delay Group setting button
10.2. Group Setting

**Step 1.** Click the Group Setting button of the signal processing to be grouped, then set the group number from the pop-up menu.

- [Group number selection pop-up (for the functions except Delay)]
- [Group number selection pop-up (only for Delay)]

![Group number selection pop-ups](image)

**Note**
In the case of Delay pop-up, [None] cannot be selected.

Up/Down scroll bar

Group number can be selected from G.1 through G.16. Selecting [None] permits cancelling the group setting.

**Notes**
- Delay has been grouped in [G.1] by default.
- For Delay, all group numbers in a Stack are always identical.
- For Delay, [None] cannot be selected.

**Step 2.** With the same operation as described in **Step 1**, assign the same number to the Group setting buttons for the same signal processing of other speakers.

**Note**
Different signal processing functions cannot be grouped even if their group number is identical. Example: When G.1 is assigned to both Speaker 1's Gain and Speaker 2's LPF/HPF, both speakers are not mutually interlocked (grouped), being independent of each other.
10.3. Screen Display and Operation at Grouping Setting

10.3.1. Display in the grouping setting view

Shown below is an example where Mute and Gain of both Speaker 1 and Speaker 2 are respectively grouped.

10.3.2. Display in the DSp view and operation in the Contents view

Group number is indicated with circled number at the upper right corner in the grouped signal process box.

When moving the Speaker 1’s fader in the Contents view (the Gain All view) to be displayed by selecting the Gain box in the DSP view as shown above, the Fader of the Speaker 2 belonging to the same group simultaneously moves, and Gain (dB) changes to the same value.
11. pRESET mEmORy OPERATION

A Preset memory is setting data that can collectively manage the followings: parameters of each filter (signal processing that can be set in the DSP view and Mixer view) built in speaker, various directivity control parameters set in the Beam Steering view, CobraNet routing settings, group settings, and Box write protect settings.

Up to 32 Preset memories (Preset Nos. 1 through 32) can be stored. One of them can be recalled as the current Preset memory.

Preset memory-related operation can be performed in the Preset Memory view or through menu operation.

11.1. preset memory view Screen Description

[preset memory view (When the preset memory list panel is closed)]

1. preset memory number
   Displays the currently selected Preset number.
   **Tip**
   In either of the following cases, the Preset memory number indicator flashes to indicate that there is a difference between the Preset memory currently loaded into the speaker and the parameters in edit with the SR-D8 PC Software.
   - When selecting the Preset memory not identical to the one loaded into the speaker
   - When changing arbitrary parameters (including Group setting and Write protect)

2. preset memory name
   Displays the currently selected Preset memory name.

3. Load button
   Loads the parameters of the currently selected Preset memory into the speaker.
   **Tip**
   The [Load] button becomes active only when selecting the Preset memory not identical to the one loaded into the speaker.
4. **Store button**
Stores the parameters into the currently selected Preset memory.

**Tip**
In either of the following cases, the [Store] button becomes active.
- When selecting the Preset memory not identical to the one loaded into the speaker
- When changing arbitrary parameters (including Group setting and Write protect)

5. **Trash button**
Abandons the changed contents when the parameter change is performed.

**Tip**
The [Trash] button becomes active in the following case:
When changing arbitrary parameters (including Group setting and Write protect) is changed.

A dialog shown below appears if this button is clicked.

To trash the parameters, click the [OK] button.
To abandon them, click the [Cancel] button, select the arbitrary Preset memory, then perform Store operation.

6. **preset memory sort button (descending order)**
Changes the selected Preset memories in descending order (32 → 31→····3 → 2 → 1).

7. **preset memory sort button (Ascending order)**
Changes the selected Preset memories in ascending order (1 → 2 → 3→···31 → 32).

8. **preset memory list panel Open/Close button**
Clicking this button while the Preset list panel is open closes the Preset list panel.

9. **Preset memory list panel**
Displays preset memory numbers and names. You can directly select the Preset memory on the Preset memory list panel.

**Tips**
- Both Preset memories loaded in the speaker and those currently selected are highlighted.
- Preset memory can be selected by clicking the mouse. The Preset memory being selected can also be moved using PC’s cursor keys.
- Pressing the PC’s Enter key recalls the selected Preset memory into speaker. Also any desired preset memory can be recalled into speaker as it is double-clicked.
11.2 preset memory Recall

Preset memory stored into speaker in advance can be recalled as the current parameter for the speaker.

**Step 1.** Select the Preset memory in the Preset memory view.
Click the Preset memory change button until the desired Preset memory number is displayed or click the desired Preset memory on the Preset memory list panel.
The selected Preset memory number flashes and the [Load] button becomes active.

**Step 2.** Click the [Load] button.
The Preset memory is recalled as the current parameter for the speaker.

**Tip**
The Preset memory can also be recalled through the menu operation. (See p. 10.)

11.3. preset memory Store

The contents of the current parameters can be stored into speaker as Preset memory.

**Step 1.** Select the Preset memory in the Preset memory view.
Click the Preset memory change button until the desired Preset memory number is displayed or click the desired Preset memory on the Preset memory list panel.
The selected Preset memory number flashes and the [Store] button becomes active.

**Step 2.** Click the [Store] button.
The contents of the current parameters are stored into speaker.

**Tip**
Contents of the current parameters can also be stored through the menu operation. (See p. 10.)
11.4. preset memory Name Change

It is possible to change Preset memory name while an arbitrary Stack exists in the System tree view.

**Step 1.** Select [Edit → Preset → Change Name] from the menu.

![Edit Preset name dialog appears.](image)

**Step 2.** Enter a new Preset memory name.
Up to 16 alphanumeric characters can be used for the Preset memory name.

**Step 3.** Click the [OK] button.

**Note**
If already existing Preset memory name is designated or no name has been entered in Preset memory name filed, the [OK] button becomes inactive.
11.5. preset memory Settings When power Is ON

The preset memory can be set to automatically load when the speaker power is switched ON.

**Step 1.** Click on [Preset → Power On] on the menu.

A list of Preset memories is displayed.

**Step 2.** Select the preset memory to be automatically loaded from the list.

- **Last Preset:** When the power is switched ON, this function automatically loads the preset memory that was last loaded before the power was switched OFF.
- **Preset 1 ~ 32:** Automatically loads the selected preset memory when the power is switched ON.
12. STORING THE SETTINGS INTO A FILE

12.1. Storing method
Store the current setting data into a new project file when the setting is complete.
(For the project, see p. 74.)

Step 1. Select [File → Save as] from the menu.

A Save As screen appears as shown below.

Step 2. Enter a file name and click the [Save] button.

Tips
- You need not enter the extension (d8s).
- Never duplicate the existing file name.
- The “Type” of file is automatically set to Project file type “SRD8Files (*.d8p).” Do not change it.
12.2. project management

The SR-D8 PC Software manages Stacks, speaker configuration, various parameters stored in preset memories as a “Project” and stores it into PC’s hard disk or external storage medium (USB flash drive or SD card) connected to a PC as Project file.

This Project file’s contents can be read into the SR-D8 PC Software or stored into PC’s hard disk or external storage medium (USB flash drive or SD card) connected to a PC through menu operation, or through operations on the Initial operation selection screen displayed after the SR-D8 PC Software start-up.

History of the Project operation, error detection, and simulation result in the Beam Steering view are kept in the form of a file and managed together with the Project file.

12.2.1. project files description
Project file and related files that the SR-D8 PC Software manages are listed below.

<table>
<thead>
<tr>
<th>File</th>
<th>Extension</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project file</td>
<td>d8p</td>
<td>A file that manages Stacks, speaker configuration, and various Parameters</td>
</tr>
<tr>
<td>Operation log file</td>
<td>d8opr</td>
<td>A file which records and contains all histories of Project read-in operation, storage operation, Preset memory operation (Load/Store/Synchronization), Stack configuration change, and online and offline statuses according to Operation log settings</td>
</tr>
<tr>
<td>Error log file</td>
<td>d8err</td>
<td>A file which records and contains various error noticed from the speaker according to Error log settings</td>
</tr>
<tr>
<td>Beam steering simulation file</td>
<td>d8spl</td>
<td>A data file which contains simulation results performed in the Beam Steering Simulation view</td>
</tr>
</tbody>
</table>

**Note**

Project files can only be read in from or written to the SR-D8 PC Software. Project may not be read or stored if its file name or file location has been changed, or if file contents have been overwritten using Windows Explorer.
13. COmmUNICATIONS BETWEEN pC AND SpEak ERS

13.1. Connecting the pC to the Speakers

Connect the PC to the SR-D8-M/SR-D8-S via a switching hub. Use a straight through cable (STP Category 5 or higher cable fitted with RJ45 connectors) for connection.

**Note:** Do not connect the LAN terminal directly to the PC.
13.2. Enabling Communications between the pC and the Speaker

Speaker network settings are required before communication between the PC and the speakers can be performed. Once the network settings are completed from the PC, the speaker can be switched to online status or bulk transmission and reception enabled.

- Speakers’ network settings (See p. 76, Connection Settings.)
- Enabling speakers online status (See p. 80, Communications.)
- Bulk reception from the speaker (See p. 82, Bulk Receiving.)
- Bulk transmission to the speakers (See p. 84, Bulk Transmission.)

**Note**: When changing the PC’s network settings, change them from the Windows Control Panel. PC network setting cannot be changed using the SR-D8 PC software.

13.3. Connection Settings (Speakers’ Network Settings)

Perform settings needed to communicate with the speakers in this section. Speakers’ network settings and firmware version confirmation can be performed.

The table below shows the factory-preset settings for each speaker.

<table>
<thead>
<tr>
<th>Model Nos.</th>
<th>SR-D8-M</th>
<th>SR-D8-S</th>
</tr>
</thead>
<tbody>
<tr>
<td>Subnet mask</td>
<td>255.255.255.0</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>Default gateway</td>
<td>0.0.0.0</td>
<td>0.0.0.0</td>
</tr>
</tbody>
</table>

**Step 1.** Select [Communication → Setting] from the menu.

The following “IP configuration of the equipment” screen is displayed and a search for speakers existing in the LAN is begun.
Network settings of the speakers detected on the network are displayed in the "IP configuration of the equipment" screen:

- If a speaker's IP address is duplicated or inappropriate network setting has been performed, such speaker is displayed in the Uncommunicatable Speakers list.
- If a speaker is selected in the list, its front-mounted Status indicator lights up.
- When multiple IP addresses are set in the PC, select a desired IP address from the PC's IP address pull-down menu.

**If no speaker was detected:**
Install the undetected speaker within the reach of broadcast packet. Communications may be interrupted when the PC is firewall-protected.

Advance to each designated Step to perform settings depending on the following cases.

- When changing the speaker IP address and sending it to the speaker, advance to **Steps 2 and 3**.
- When adding the speakers to be connected via a router, advance to **Step 4**.
  **Note:** When connecting to the speaker via a router, such speaker cannot be displayed on this screen. Nor the speaker's network setting can be changed. Connect such speaker to a LAN and perform network setting in advance.
- When the speaker not to be online is displayed, advance to **Step 5**.
- When the speakers to be connected are all displayed in the "Communicatable Speakers," advance to **Step 6**.

**Step 2.** Change the speaker's network setting.
Select the speaker for which you want to change the network setting, then click the [Modify IP setting] button. The IP Setting screen is displayed.
Set the IP address, then click the [OK] button.

**Step 3.** Send changed setting data to the speaker.
Clicking the [To send the configuration change] button sends the IP settings to the corresponding speaker and speakers' network settings are changed.
Step 4. Add the speaker to be connected via a router in a list.
Clicking the [Add] button displays the Add target speaker screen.
Enter the IP address of the added speaker and click the [OK] button.
Note
Network setting for the speaker to be connected via a router cannot
be changed using the method described in Step 2.
If you need to change the network setting, connect such speaker to
a LAN and change the network setting in advance.

Step 5. Delete the speaker from the list.
Select the speaker to be deleted, if any, then click the [Delete] button.
The selected speaker is deleted from the list.

Step 6. Click the [Next] button.
Firmware version data is automatically retrieved from the speakers in the Communicatable Speakers List.
The following Firmware version check screen is displayed after firmware version check completion.

Note
If the installed SR-D8 PC Software version is not latest,
the dialog shown at right is displayed.
Install the latest version of software to the PC.
Concerning the latest version of software, consult your nearest TOA dealer.

Step 7. Update the firmware.
Select speakers from the Uncontrollable Speakers list and click the [Firmware update] button.
Firmware is updated.
After firmware update completion, the speakers are moved to and displayed in the [Controllable Speakers] list.
Step 8. Click the [Next] button. 
Clicking the [Next] button displays the Setting the speaker name screen.

Step 9. Change the speaker name. 
Select a speaker from the Uncontrollable Speakers list, click the [Modify the speaker name] button. The Setting the speaker name dialog is displayed.

Step 10. Select a speaker name from the pull-down menu and click the [OK] button.

Step 11. Send the changed setting data to the speaker. 
Clicking the [To send the configuration change] button sends the speaker name to the corresponding speaker to change its name.

Step 12. Light up the speaker's Status indicator. 
Select the speaker and click the [Light the Status LED] button, then the Status indicator on the corresponding speaker's front lights up. This will help you check to see if the corresponding speaker is located in a correct position.

Step 13. Click the [Finish] button. 
Connection setting is complete.
13.4. Communications

Perform connection to the speaker for online processing.

**Step 1.** Select [Communication → Connect] from the menu.

The During connection confirmation dialog is displayed.

The Communication screen is displayed if there is no problem with the connection settings for all the speakers.

**When the connection setting is not completed**

As the “IP configuration of the equipment” screen is displayed, perform the connection setting. (See p. 76, Connection Settings.)

The communication screen is displayed when the connection setting is complete.

**When there is a problem with the connection settings**

The indication “Communication error” or “Version error” is displayed in the status field of the During connection confirmation dialog.

When performing the connection setting, click the [Connection setting] button. (See p. 76, Connection Settings.)

When connecting only to the speakers that have no problem, click the [Skip the connection confirmation] button.
Step 2. Synchronize the setting data between the PC and speakers.
To establish communication between the PC and speakers, the mutual setting contents must be identical.
If the setting contents of the PC and connected speakers are not equal, the indication "Unmatch" is displayed in the status field of the Communication screen.
In this case, both setting contents of the PC and speakers can be matched by transferring the unmatched data from PC to the speakers or vice versa.

2-1. Select the desired transfer direction with the "Transfer direction" radio button.

2-2. Click the [Update] button.

Step 3. Click the [Finish] button.
The speakers are brought into online status.
13.5. Bulk Receiving

This function searches for speakers connected on the network and simultaneously transfers the setting contents from all detected speakers to the PC. After transfer, a stack structure is built based on the setting contents transferred from the connected speakers.

**Step 1.** Select [Communication → Bulk Receiving] from the menu.

*Note:* Alternatively, click the [Bulk Receive] button on the Initial operation selection screen.

A search for connected speakers on the network automatically begins as shown below:

The Bulk receive screen is displayed when the search is complete.

**Step 2.** Add the speaker as needed.

Clicking the [Add] button displays the Add target speaker screen of the connected speaker.

Enter the IP address of the speaker to be added, then click the [OK] button.

When there is a problem with the speaker to which you assigned the IP address, the dialog at right is displayed, and such speaker is not a subject for Bulk reception.
Step 3. Delete the speaker as needed.
Select the speaker to be deleted, then click the [Delete] button.

Step 4. When all speakers for Bulk reception are ready, click the [Start] button.
The screen shown below is displayed, and the Bulk reception begins.

![Bulk reception screen]

The screen below is displayed after Bulk reception is complete.

![Completed Bulk reception screen]

Step 5. Click the [Finish] button.
Stack configuration received from the speakers is created in the System tree view, placing the speakers in online status.
13.6. Bulk Transmission

This function simultaneously transmits PC setting contents to all speakers on the network.

**Step 1.** Select [Communication → Bulk Transmission] from the menu. The screen for searching for the speakers on the network is displayed.

The “IP configuration of the equipment” screen is displayed after search for speakers is complete.

When the connection setting is not completed

The [Next] button is inactive. Perform the connection setting by clicking the [Modify the IP setting] button. (See p. 76, Connection Settings.) Also, click the [To send the configuration change] button to send the changed setting data to the speakers. The [Next] button becomes active when the connection setting is complete.

**Step 2.** Click the [Next] button.
The During connection confirmation dialog is displayed.

Bulk transmission is automatically made to the speakers, then the communication screen is displayed.

The screen below is displayed after Bulk transmission is complete.

**Step 3.** Click the [Finish] button.  
Bulk Transmission is completed.
14. AUTHORIZATION SETTINGS AND Operation

14.1. User level and Security Settings

14.1.1. What is User level?

The SR-D8 PC Software offers the following two types of user levels for use in each project:

- **Administrator**: This user level has higher authority than the operator.
  - If the user level settings are disabled, the default user level is automatically set to Administrator.
  - If the user levels are enabled and log-on is performed from the menu as an administrator, the Administrator user level is put into effect.
  - When the user levels are enabled, a preset password is required to log on as an administrator.

- **Operator**: This user level has a lower authority than Administrator.
  - If the user level settings are enabled and log-on is not performed from the menu as an administrator, the Operator user level is put into effect.

14.1.2. Operations that can be prohibited

If the project's user level is enabled, the following operations can be prohibited or limited depending on user level:

- Addition and deletion of stacks
- Stack and speaker name changes
- Beam steering changes
- Preset memory storage (designation for each preset number)
14.1.3 Enabling User levels

**Step 1.** Select [Option → Security Setting] from the menu.

The Security Setting dialog is displayed.

**Step 2.** Place a checkmark in the checkbox for [Enable User Level].

The Password for Administrator dialog is displayed.

**Step 3.** Enter the password in the [Password] and [Confirm Password] entry fields.

**Notes**
- Use 4 – 16 characters to enter the password. The password is case-sensitive.
- If the password is forgotten, it will be impossible to log-on in Administrator mode, thus restricting setting changes. Take great care regarding password management.

**Step 4.** Click the [OK] button.
Step 5. Click the [OK] button.
The user level is enabled.

Note
The results in the Security Setting dialog are not automatically stored in the project. To keep such results valid for the next time, store the contents in the project after setting in the Security Setting dialog.

14.1.4. performing Security Settings

Step 1. Select [Option → Security Setting] from the menu.

The Security Setting dialog is displayed.
Step 2. Select a security level from the pull-down menu for each security setting item.

Four different security levels can be set for each item.

<table>
<thead>
<tr>
<th>Security Level</th>
<th>Security Level Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>For the corresponding item, both the Administrator and Operator can change parameters, perform various operations and change security settings.</td>
</tr>
<tr>
<td>Low</td>
<td>For the corresponding item, the Administrator can change parameters, perform various operations and change security settings. The Operator cannot change parameters or perform any operation, but can change security settings.</td>
</tr>
<tr>
<td>Mid</td>
<td>For the corresponding item, the Administrator can change parameters, perform various operations and change security settings. The Operator cannot change parameters, perform any operation nor change security settings.</td>
</tr>
<tr>
<td>High</td>
<td>For the corresponding item, the Administrator cannot change parameters or perform any operation, but can change security settings. The Operator cannot change parameters, perform any operation nor change security settings.</td>
</tr>
</tbody>
</table>

Step 3. Click the [OK] button.

Tip
The results in the Security Setting dialog are not automatically stored in the project. To keep such results valid for the next time, store the contents in the project after setting in the Security Setting dialog.
14.2. Box Write-protection
Prohibition of changes to parameters of function boxes displayed on the DSP view can be set for each box.

Step 1. Select [Option → Box Write Protect] from the menu.

Step 2. Select the security level from the pull-down menu of each security setting item.

Step 3. Click the [OK] button.

The write-protected “Gain” box on the DSP view is displayed along with a locked mark as shown at right, disabling parameter changes.
14.3. Administrator log-On

The user must be logged-on as Administrator in order to perform the following operations in projects for which the user level is active:
- User level active/inactive setting change.
- Operation or change of items set to a security level (Low/Mid/High) that cannot be changed by the Operator.
- Change of items set to a security level (Mid/High) that cannot be changed by the Operator, or box write protection settings.

14.3.1. logging-On as the Administrator

When a project is loaded with user level enabled, the user level is set to Operator by default. To perform tasks as an Administrator, the user must log-on from the menu as the Administrator.

Step 1. Select [Option → Logon Administrator] from the menu.

The Administrator Logon dialog is displayed.

Step 2. Enter the password.

Step 3. Click the [OK] button.

14.3.2. Administrator log-Off

When a user has been logged on as an Administrator, if the Administrator's privilege becomes unnecessary, log-off the Administrator.

Select [Option → Logoff Administrator] from the menu.
15. LOG

The SR-D8 PC Software stores operation logs and system error logs in the log file. However, since such logs cannot be read as they are, the software also features a function that allows such log data to be read or output in CSV format.

The SR-D8 PC Software offers the following two types of log: Operation log and Error log.

Operation log: Stores logs regarding loading or storage of projects, preset memory operations (loading, storage, and synchronization), stack configuration changes, and communication start and cutoff in the operation log file according to operation log settings.

Error log: Stores various error notices sent out from the speaker in the error log file according to error log settings.

15.1. Operation log Settings

Select the operation logs to be stored.

Step 1. Select [Option → Operation Log → Setting] from the menu.

The Operation Log Setting dialog is displayed.

Step 2. Place a checkmark in the box of operation log type to be stored.

Shown below are description of log types.

<table>
<thead>
<tr>
<th>Operation Log Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open And Save Project</td>
<td>[Open Project]: Log of operations to open a project or create a new project.</td>
</tr>
<tr>
<td></td>
<td>[Save Project]: Log of operations to save a project.</td>
</tr>
<tr>
<td>Load Preset</td>
<td>Log of operation loading preset memory into a speaker.</td>
</tr>
<tr>
<td>Store Preset</td>
<td>Log of operation storing preset memory.</td>
</tr>
<tr>
<td>Sync Preset</td>
<td>Log of operation synchronizing preset memory between PC and speaker.</td>
</tr>
<tr>
<td>Modify Stack</td>
<td>Log of operation changing stack or speaker configurations.</td>
</tr>
<tr>
<td>Connect And Disconnect</td>
<td>[Connect]: This log shows when communications between PC and speaker start (the speaker comes online).</td>
</tr>
<tr>
<td></td>
<td>[Disconnect]: This log shows when communications between PC and speaker ends (the speaker goes offline).</td>
</tr>
</tbody>
</table>

Step 3. Click the [OK] button.
15.2. Reference to Operation logs

Operation logs checked in the operation log settings are stored as logs. The stored operation logs can be referenced from the SR-D8 PC Software. The files can also be searched under specific conditions when referenced, or provide file output.

15.2.1. Referencing Operation logs

Select [Option → Operation Log → Reference] from the menu.

The Operation Log screen is displayed.

1. Search Category Selection Button
Selects the search condition for operation log from the pull-down menu.
Following are search conditions.
• All
• Year
• Year/Month
• Year/Month/Day
• Log ID

2. Open Project
3. Save Project
4. Load Preset
5. Store Preset
6. Synchronous Preset (PC >> Speaker) *1
7. Synchronous Preset (Speaker >> PC) *2
8. Modify Stack
9. Connected
10. Disconnected

1. Stack name
2. Speaker name
3. User level

*1 Log of synchronizing and updating of speaker preset memory using the preset memory managed by the PC
*2 Log of synchronizing and updating of PC preset memory using the preset memory stored in the speakers
2. Operation Log List
Displays operation logs in reverse chronological order (beginning with the most recent). All logs are shown when displayed by default.
Operation logs are composed of the following items:
• Date: Date and time that the operation log was acquired.
• Log ID: Operation category of the acquired log.
• Stack Name: Stack name used for operation.
• Speaker Name: Speaker name used for operation.
• User Level: User level used for operation.

3. Search Button
Searches for operation logs based on the search category selected with the Search Category Selection button (1).

4. Clear History Button
Clears operation logs being displayed.

5. Export Button
Exports operation logs to the file in CSV format.

6. Close Button
Closes the Operation Log screen.

15.2.2. Searching Operation log
Step 1. Select the search condition from the pull-down menu by clicking the Search category selection button.

Step 2. Click the [Search] button.
Retrieved operation logs are displayed.
15.2.3. Exporting operation logs to the file

**Step 1.** Click the [Export] button.

The Save As dialog is displayed.

**Step 2.** Enter a file name, then click the [Save] button. The file format is automatically set in CSV (Comma Separated Value, "csv" extension) format.
15.3. Error log Settings

Error logs can be selected for storage.

**Step 1.** Select [Option → Error Log → Setting] from the menu.

The Error Log Setting screen is displayed.

**Step 2.** Place a checkmark in the box of Error log type to be stored. Shown below are description of log types.

<table>
<thead>
<tr>
<th>Error Log Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature Error</td>
<td>Log of notices received from speakers about detected temperature errors.</td>
</tr>
<tr>
<td>Over Current</td>
<td>Log of notices received from speakers about detected over current.</td>
</tr>
<tr>
<td>CobraNet DSP Error</td>
<td>Log of notices received from speakers about detected CobraNet DSP errors.</td>
</tr>
<tr>
<td>DSP Error</td>
<td>Log of notices received from speakers about detected DSP errors.</td>
</tr>
<tr>
<td>Fault Status</td>
<td>Log of notices received from speakers about detected fault status.</td>
</tr>
<tr>
<td>Network Error</td>
<td>Log of notices received from speakers about detected network errors.</td>
</tr>
</tbody>
</table>

**Step 3.** Click the [OK] button.
15.4. Reference to Error logs

Error logs checked in the error log setting are stored as a log. Reference can be made to the stored error logs from the SR-D8 PC Software. The logs can also be searched under specific conditions when referenced, or the file can be output.

15.4.1. Referencing Error logs

Select [Option → Error log → Reference] from the menu.

The Error Log screen is displayed.

1. Search Category Selection Button
   Selects the search condition for error log from the pull-down menu. Following are search conditions.
   • All
   • Year
   • Year/Month
   • Year/Month/Day
   • Error ID
     Temperature Error
     Over Current
     CobraNet DSP Error
     DSP Erroe
     Fault Status
     Network Error
   • Phenomenon

2. Error Log list
   Displays error logs in reverse chronological order (beginning with the most recent). All error logs are shown when displayed by default.

Error logs are composed of the following items:
   • Date: Date and time that the error log was acquired.
   • Error ID: Error category notified from the speaker.
   • Phenomenon: Classification showing the phenomena (occurrence or recovery) from the error.
• Stack Name : Name of stack that generated or was restored from the error.
• Speaker Name : Name of speaker that generated or was restored from the error.

3. Search Button
Searches for error logs based on the search category selected with the Search Category Selection button(1).

4. Clear History Button
Clears error logs being displayed.

5. Export Button
Exports error logs to the file in CSV format.

6. Close Button
Closes the Error Log screen.

15.4.2. Searching Error log
Step 1. Select the search condition from the pull-down menu by clicking the Search category selection button.

Step 2. Click the [Search] button.
Retrieved operation logs are displayed.
15.4.3. Exporting error logs to the file

Step 1. Click the [Export] button.

The Save As dialog is displayed.

Step 2 Enter a file name, then click the [Save] button.
The file format is automatically set in CSV (Comma Separated Value, "csv" extension) format.
16. Gl OSSARy

16.1 System Basic Items

Speaker
A physical speaker system.

Stack
A line array speaker system consisting of one or more speakers. Multiple speakers are physically connected. Individual speakers must always belong to a stack, and up to 4 speakers can be included in a single stack. An entire system can contain up to 4 stacks.

Local Link
A digital audio link used to transmit audio signal from the main speaker to the sub-speakers in the stack in which two or more speakers are connected.

Main Speaker
SR-D8-M.
One of the speakers making up a stack and having Analog and CobraNet inputs, CobraNet output, and local link output that transmits audio signal to the sub-speakers within the same stack. It is also provided with a mixer function, and signals processed from Analog Inputs 1 and 2 and CobraNet Inputs 1 – 4 can be directed to Mix Out 1 and Mix Out 2, which in turn output such processed signals to each sub-speaker.

Sub-Speaker
SR-D8-S.
One of the speakers making up a stack. It has a Local Link Input terminal that receives audio signal from the main speaker’s Local Link Output, and a Local Link Through terminal that forwards received audio on to another sub-speaker within the same stack.

Input Channel
The SR-D8 speaker system has a total of 6 input channels (Analog Inputs 1 – 2 and CobraNet Inputs 1 – 4).

CobraNet
A format that uses the Ethernet network to distribute multi-channel digital audio. The SR-D8 speaker system supports CobraNet audio input. For details about CobraNet, refer to Cirrus Logic, Inc.’s CobraNet site http://www.cobranet.info/.

Bundle, Receive Bundle, and Transmit Bundle
In CobraNet, audio data is input and output in digital units called “bundles.” A receive bundle inputs audio data from external equipment to the speaker using CobraNet. A transmit bundle outputs audio data from the speaker to external equipment using CobraNet.
**Bundle Number**
The CobraNet bundle is managed by bundle numbers. To receive audio data transmitted from the CobraNet device, the transmitting device’s transmit bundle number must match the receiving device’s receive bundle number. Set the bundle number to 1 – 65279, depending on the intended use.

- Bundle No. 1 – 255: Multicast bundle
- Bundle No. 256 – 65279: Unicast bundle

**Multicast Bundle**
Bundles set to CobraNet bundle number of 1 – 255. The same audio data can be simultaneously transmitted from the transmitting device to all receiving devices within a network.

**Unicast Bundle**
Bundles set to CobraNet bundle number 256 – 65279. Audio data is transmitted and received between transmitting and receiving devices on a 1:1 basis.

**System Link Delay**
A function that adds a delay to the audio output of the CobraNet output side’s stack itself in order to adjust the audio signal time difference generated at the audio reception point in the CobraNet connection between stacks.

**Preset Memory**
A function that allows the parameters of each filter (signal processing capable of being set in the DSP view or Mixer view) installed in the speaker, various directivity control parameters set in the Beam Steering view, CobraNet routing settings, group settings, etc. to be assembled and managed as “preset memory.” Up to 32 preset memories can be independently stored and accessed. Preset memory data is stored in both each speaker and the project file as well.

**Synchronization**
The act of matching all the different parameters managed by both the speakers and SR-D8 PC Software. Synchronization is mainly implemented the first time communication is initiated between the speakers and SR-D8 PC Software.

**pC**
Refers to a Personal Computer in which the SR-D8 PC Software is installed.

**SR-D8 pC Software**
Software described in this manual and installed in a PC for use in setting up the SR-D8 speaker system.

**Fault Status**
The state in which audio signal can be directly input from the Analog 1 input terminal to a digital amplifier without passing through the speaker’s internal CPU by shorting the terminals of a removable terminal block.
16.2. pC Software Screen Display

**System Tree view**
A screen view that allows stack or speaker configurations to be displayed and edited.

**System Configuration View**
A screen view that shows the CobraNet routing and group setting buttons that allow such settings to be performed when clicked on.

**preset memory view**
Displays the preset memory currently being loaded into the SR-D8 PC Software. From this view, preset memory can be switched and loaded to or stored in the speaker.

**main view**
A screen view that displays the status of each speaker and function box. The function box's parameters can be changed by operating the buttons on the box.

**Contents view**
Interlocked with the main view, this screen displays detailed contents of each function box and permits each input value to be set and faders operated. The content view can be displayed in either docking or floating display formats.

**Docking Display**
A view format in which the contents view is docked and displayed in the lower half of the main view.

**Floating Display**
A view format in which the contents view is separated from the lower half of the main view to float over the main screen as a different window. Further, the Mute All view is always shown in floating format if display operation is performed.

**Box**
A box expressing each signal processing function (filter) in the DSP and Mixer views. Also referred to as a function box.

**Context menu**
This menu that appears when right-clicking on the system tree view, the DSP view or the Mixer view. When an item on each view, stack, speaker or function box is right-clicked, a pop-up list showing currently available operations for the selected item is displayed.

**pull-Down menu**
This menu appears on the screen when either the menu or individual buttons are selected (left-clicked). Available operations or choices are displayed for the selected item or button.

**Dialog**
This screen is mainly displayed for setting input values or confirming operations. Click [OK] or [Yes] after confirming the contents or input value. To abort or cancel an operation, click [Cancel] or [No]. (Buttons differ depending on the dialog being displayed.)

**project**
In the SR-D8 PC Software, stack or speaker configurations, preset memory contents, user levels, and operation or error log settings are all managed together as a "project," and stored on the PC hard drive or external storage media (USB flash drive, SD card, etc.) connected to the PC. Stored projects can be independently loaded.
16.3. Signal processing Functions

Auto mix
A box that can set the gate and ducker functions for input channels in the Mixer view. To change their settings, select the desired function tab in the contents view when the box is selected.

Gate Function
A function that can pass, attenuate, or cut the input signal, depending on the input signal level. The gate function passes the signal when in the open state, and attenuates or cuts it when in the closed state. The gate switches to open state if the input level exceeds the total level of the threshold level and a hysteresis value. Once open, the gate closes again when the input level lowers the level that results from subtracting the hysteresis value from the threshold level. Operations to open or close the gate control the ducker function.

Ducker Function
One of the auto-mixing functions that automatically adjusts each input channel gain depending on the input signal level. When a signal exceeding the gate threshold level is received, the ducker function automatically attenuates other input signals with a lower priority than the input channel.

16.4. System Functions

User level
The authority classification for restricting operable items. Two levels are available: “Administrator” and “Operator.”

Security Settings
A function that prohibits settings from being changed using a PC (SR-D8 PC Software). Perform settings for items for which security settings can be performed using a PC (SR-D8 PC Software). Depending on the user level, 4 security levels can be set as Off/Low/Mid/High.

Box Write-protection
A function that prohibits changes to box parameters in the DSP view using a PC (SR-D8 PC Software). The settings for each box in the DSP view are performed using a PC (SR-D8 PC Software). Depending on the user level, 4 prohibition levels can be set as Off/Low/Mid/High.

16.5. Terms Relating to Communication

Online State
The state that the PC (SR-D8 PC software) is communicating with the speakers.

Offline State
The state that the PC (SR-D8 PC software) is not communicating with the speakers.

Bulk Transmission
Transfer of individual parameters stored in a PC (SR-D8 PC Software) to speakers in communicable status within the network.

Bulk Reception
Transfer of each parameter from all speakers in communicable status within the network to a PC (SR-D8 PC Software). This function also sets speaker/stack configurations in the system tree view based on the transferred setting contents.
16.6. Terms Relating to Beam Steering

Beam Steering
In the SR-D8 PC Software, the term “Beam Steering” refers to an operation function called audio “directivity control,” which changes the vertical angle and width of the beam emitted from the SR-D8 speaker system. The SR-D8 PC Software allows this “directivity control” to be independently set or simulated for individual stacks.

Beam
Represents the audio direction emitted from the SR-D8 speaker system. In the SR-D8 speaker system, up to 2 beams can be emitted per stack.

Beam Steering view
A screen view that is displayed when “Beam Steering” is selected from the operation view tab displayed when the stack is selected. In this view, various parameters for Beam Steering can be set, including speaker installation conditions, speaker installation space depth and beam emission angles.

Beam Steering Simulation view
Performs simulations based on various parameters set in the Beam Steering view, and graphically displays the results by means of sound pressure distribution.

Beam Steering Graph view
Displays sound pressure graphs for audience settings. Nothing is displayed when audience is not set or simulation is not being performed.

Setting Origin (Beam Steering view: Speaker Settings)
The location position that makes up the base for the speaker (stack) installation. This can be the front upper side, front lower side, rear upper side or rear lower side of the speaker (stack).
Installation Angle (Beam Steering view: Speaker Settings)
The installation angle for speakers (stacks). The angle formed when the speaker tilts forward against the vertical line from the speaker (stack) installation base point is a negative angle, and the angle formed when tilted backward is a positive angle. A zero-degree installation angle means that the speaker (stack) is installed in alignment with the vertical line from the installation base point.

[Installation angle when the installation base point is the front upper side]

Beam Angle (Beam Steering view: Steering Settings)
An axial directional angle of the beam emitted from the speaker (stack). Because the speaker's (stack's) front axial angle is zero degree, the beam angle is a negative angle when the speaker (stack) faces downward, and a positive angle when the speaker (stack) faces upward.

Beam Width (Beam Steering view: Steering Settings)
Represents the width that the beam broadens when emitted from the speaker (stack) in the downward direction. Settings are performed in such ways as what degree of width in the downward direction from the speaker (stack) beam angle.

[Beam angle and beam width when the installation base point is the front upper side and the installation angle is zero degree]

Depth (Beam Steering view: Space Settings)
The depth of the speaker (stack) front direction in the space (place) where the speaker (stack) is installed.

Audience (Beam Steering: Audience Settings)
Represents the audience area installed in the space (place) where the speaker (stack) is installed. Performing audience settings allows the sound pressure graph for the audience to be confirmed in the Beam Steering Graph view.
17. Specifications

17.1. Software Specifications

Verified OS: 32/64-bit Windows 7, 32/64-bit Windows 10
Required component: .NET Framework 4 Client Profile
Number of Preset memories: 32

17.2. Setting Items, Setting Ranges, and Default Settings

17.2.1. Signal processing box (DSp view)

<table>
<thead>
<tr>
<th>[Input Selector]</th>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Channel</td>
<td>Analog1, Analog2, CobraNet1, CobraNet2, CobraNet3, CobraNet4, Mix Out1, Mix Out2</td>
<td>Analog1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Input Gain</td>
<td>+0 dB, +6 dB, +12 dB</td>
<td>+6 dB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>[Mute]</th>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute ON/OFF</td>
<td>ON, OFF</td>
<td>OFF</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>[Gain]</th>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gain</td>
<td>–20 dB to +20 dB</td>
<td>0 dB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Polarity</td>
<td>Normal, Inverse</td>
<td>Normal</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>[LPF/HPF]</th>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type of Filter Slope</td>
<td>Through, 6 dB, 12 dB Bessel, 12 dB Butterworth, 12 dB Linkwitz-Riley, 12 dB Variable-Q, 18 dB Bessel, 18 dB Butterworth, 18 dB Variable-Q, 24 dB Bessel, 24 dB Butterworth, 24 dB Linkwitz-Riley</td>
<td>Through</td>
<td>Settable when selected except Through</td>
<td></td>
</tr>
<tr>
<td>Freq. (Cutoff frequency)</td>
<td>20 Hz to 20.0 kHz</td>
<td>LPF (except Through): 10 kHz, HPF (except Through): 100 Hz, Through: None</td>
<td>Settable when selected except Through</td>
<td></td>
</tr>
<tr>
<td>Q</td>
<td>0.500 to 2.563</td>
<td>Filter except Through: 0.500, Through: None</td>
<td>Settable when “12 dB Variable-Q” or “18 dB Variable-Q” is selected</td>
<td></td>
</tr>
</tbody>
</table>
### Filter (All filter types)

**Note:** Setting items for each filter are described later.

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Filter Type</strong></td>
<td>Through, PEQ, HPF (6 dB), HPF (12 dB), LPF (6 dB), LPF (12 dB), High Shelving, Low Shelving, All Pass, Notch, Horn EQ</td>
<td>Through</td>
<td></td>
</tr>
<tr>
<td><strong>Freq.</strong></td>
<td>PEQ: 20 Hz to 20.0 kHz, HPF (6 dB): 20 Hz to 20.0 kHz, HPF (12 dB): 20 Hz to 20.0 kHz, LPF (6 dB): 20 Hz to 20.0 kHz, LPF (12 dB): 20 Hz to 20.0 kHz, High Shelving: 6.00 kHz to 20.0 kHz, Low Shelving: 20 Hz to 500 Hz, All Pass: 20 Hz to 20.0 kHz, Notch: 20 Hz to 20.0 kHz</td>
<td>PEQ: 1.00 kHz, HPF (6 dB): 100 Hz, HPF (12 dB): 100 Hz, LPF (6 dB): 10.0 kHz, LPF (12 dB): 10.0 kHz, High Shelving: 6.00 kHz, Low Shelving: 500 Hz, All Pass: 1.00 kHz, Notch: 1.00 kHz</td>
<td>PEQ, HPF (6 dB), HPF (12 dB), LPF (6 dB), HPF (12 dB), High Shelving, Low Shelving, All Pass, Notch Settable when above items are selected</td>
</tr>
<tr>
<td><strong>Gain</strong></td>
<td>PEQ: -15.0 dB to 15.0 dB, High Shelving: -15.0 dB to 15.0 dB, Low Shelving: -15.0 dB to 15.0 dB, Horn EQ: 0.0 dB to 18.0 dB</td>
<td>PEQ: 0.0 dB, High Shelving: 0.0 dB, Low Shelving: 0.0 dB, Horn EQ: 0.0 dB</td>
<td>PEQ, High Shelving, Low Shelving, Horn EQ Settable when above items are selected</td>
</tr>
<tr>
<td><strong>Q</strong></td>
<td>PEQ: 0.267 to 69.249, HPF (12 dB): 0.500 to 2.563, LPF (12 dB): 0.500 to 2.563, All Pass: 0.267 to 69.249, Notch: 8.651 to 69.249</td>
<td>PEQ: 4.318, HPF (12 dB): 0.500, LPF (12 dB): 0.500, All Pass: 0.267, Notch: 8.651</td>
<td>PEQ, HPF (12 dB), LPF (12 dB), All Pass, Notch Settable when above items are selected</td>
</tr>
<tr>
<td><strong>Filter ON/OFF</strong></td>
<td>On, Off</td>
<td>On</td>
<td>Settable when selected except Through</td>
</tr>
</tbody>
</table>

[Filter: PEQ (Parametric Equalizer) setting items]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Freq.</strong> (Center frequency)</td>
<td>20 Hz to 20.0 kHz</td>
<td>1.00 kHz</td>
<td></td>
</tr>
<tr>
<td><strong>Gain</strong> (Boost/cut)</td>
<td>-15.0 dB to 15.0 dB</td>
<td>0.0 dB</td>
<td></td>
</tr>
<tr>
<td><strong>Q</strong></td>
<td>0.267 to 69.249</td>
<td>4.318</td>
<td></td>
</tr>
</tbody>
</table>

[Filter: HPF (6 dB) (High Pass Filter, 6 dB/oct) setting items]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Freq.</strong> (Cutoff frequency)</td>
<td>20 Hz to 20.0 kHz</td>
<td>100 Hz</td>
<td></td>
</tr>
</tbody>
</table>
### Filter: HPF (12 dB) (High Pass Filter, 12 dB/oct) setting items

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freq. (Cutoff frequency)</td>
<td>20 Hz to 20.0 kHz</td>
<td>100 Hz</td>
<td></td>
</tr>
<tr>
<td>Q</td>
<td>0.500 to 2.563</td>
<td>0.500</td>
<td></td>
</tr>
</tbody>
</table>

### Filter: LPF (6 dB) (Low Pass Filter, 6 dB/oct) setting items

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freq. (Cutoff frequency)</td>
<td>20 Hz to 20.0 kHz</td>
<td>10.0 kHz</td>
<td></td>
</tr>
<tr>
<td>Q</td>
<td>0.500 to 2.563</td>
<td>0.500</td>
<td></td>
</tr>
</tbody>
</table>

### Filter: LPF (12 dB) (Low Pass Filter, 12 dB/oct) setting items

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freq. (Cutoff frequency)</td>
<td>20 Hz to 20.0 kHz</td>
<td>10.0 kHz</td>
<td></td>
</tr>
<tr>
<td>Q</td>
<td>0.500 to 2.563</td>
<td>0.500</td>
<td></td>
</tr>
</tbody>
</table>

### Filter: High Shelving setting items

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freq. (Roll-off frequency)</td>
<td>6.00 kHz to 20.0 kHz</td>
<td>6.00 kHz</td>
<td></td>
</tr>
<tr>
<td>Gain (Boost/cut)</td>
<td>-15.0 dB to 15.0 dB</td>
<td>0.0 dB</td>
<td></td>
</tr>
</tbody>
</table>

### Filter: Low Shelving setting items

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freq. (Roll-off frequency)</td>
<td>20 Hz to 500 Hz</td>
<td>500 Hz</td>
<td></td>
</tr>
<tr>
<td>Gain (Boost/cut)</td>
<td>-15.0 dB to 15.0 dB</td>
<td>0.0 dB</td>
<td></td>
</tr>
</tbody>
</table>

### Filter: All Pass setting items

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freq. (Frequency phase inversion)</td>
<td>20 Hz to 20.0 kHz</td>
<td>1.00 kHz</td>
<td></td>
</tr>
<tr>
<td>Q</td>
<td>0.267 to 69.249</td>
<td>0.267</td>
<td></td>
</tr>
</tbody>
</table>

### Filter: Notch setting items

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freq. (Center frequency)</td>
<td>20 Hz to 20.0 kHz</td>
<td>1.00 kHz</td>
<td></td>
</tr>
<tr>
<td>Q</td>
<td>8.651 to 69.249</td>
<td>8.651</td>
<td></td>
</tr>
</tbody>
</table>

### Filter: Horn EQ setting items

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gain</td>
<td>0.0 dB to 18.0 dB</td>
<td>Horn EQ: 0.0 dB</td>
<td></td>
</tr>
</tbody>
</table>
### Scale for LPF/HPF and Filter

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Min.</td>
<td>20.0 Hz to 19.9 kHz</td>
<td>20.0 Hz</td>
<td>Min.&lt;Max. relation is retained.</td>
</tr>
<tr>
<td>Frequency Max.</td>
<td>20.1 Hz to 20.0 kHz</td>
<td>20.0 kHz</td>
<td>Min.&lt;Max. relation is retained.</td>
</tr>
<tr>
<td>Amplitude Top</td>
<td>-119.0 dB to 200.0 dB</td>
<td>18.0 dB</td>
<td>Bottom&lt;Top relation is retained.</td>
</tr>
<tr>
<td>Amplitude Bottom</td>
<td>-200.0 dB to 119.0 dB</td>
<td>18.0 dB</td>
<td>Bottom&lt;Top relation is retained.</td>
</tr>
<tr>
<td>Amplitude Step</td>
<td>1.0 dB to 20.0 dB in 1 dB steps</td>
<td>3.0 dB</td>
<td></td>
</tr>
</tbody>
</table>

### Comp.

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comp. Mode</td>
<td>Peak,RMS,Peak/RMS</td>
<td>Peak</td>
<td></td>
</tr>
<tr>
<td>Threshold</td>
<td>-20 dB to 20 dB in 1 dB steps</td>
<td>0 dB</td>
<td></td>
</tr>
<tr>
<td>Ratio</td>
<td>1:1, 1.1:1, 1.2:1, 1.3:1, 1.5:1, 1.7:1, 2:1, 2.3:1, 2.6:1, 3:1, 4:1, 7:1, 8:1, 10:1, 12:1, 20:1, ∞:1</td>
<td>1:1</td>
<td></td>
</tr>
<tr>
<td>Knee Type</td>
<td>Hard, Soft1, Soft2</td>
<td>Hard</td>
<td></td>
</tr>
<tr>
<td>Attack</td>
<td>0.2, 0.5, 0.7, 1.0, 1.5, 2.0, 3.0, 5.0, 7.0, 10, 20, 50, 70, 100, 120, 150, 200, 250, 300, 500, 700, 1000, 2000, 3000, 5000 (ms)</td>
<td>10 ms</td>
<td></td>
</tr>
<tr>
<td>Release</td>
<td>10, 20, 50, 70, 100, 120, 150, 200, 250, 300, 500, 700, 1000, 2000, 3000, 5000 (ms)</td>
<td>500 ms</td>
<td></td>
</tr>
<tr>
<td>Gain</td>
<td>-∞, -69 to 10 dB in 1 dB steps</td>
<td>0 dB</td>
<td></td>
</tr>
<tr>
<td>Comp. ON/OFF</td>
<td>On, Off</td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>
### Delay

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increments (variable minimum unit)</td>
<td>21 µsec, 1 ms, 10 ms, 100 ms</td>
<td>21 µsec</td>
<td>Time is determined by set Distance (Delay distance). Step is determined by set Increments.</td>
</tr>
<tr>
<td>Time (Delay time)</td>
<td>0 ms to 682.646 ms in variable steps</td>
<td>0 ms</td>
<td>Time is determined by set Distance (Delay distance). Step is determined by set Increments.</td>
</tr>
<tr>
<td>Distance (Time delay distance)</td>
<td>0 meters to 235.042 meters</td>
<td>0 meters</td>
<td>Time is determined by set Distance (Delay distance). Step is determined by set Increments.</td>
</tr>
</tbody>
</table>

### Delay Option

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distance (Unit)</td>
<td>meters, inches, feet</td>
<td>meters</td>
<td>Setting Range depends on selecting Centigrade or Fahrenheit.</td>
</tr>
<tr>
<td>Temperature</td>
<td>−30.000 to 50.000°C</td>
<td>21.000</td>
<td>Setting Range depends on selecting Centigrade or Fahrenheit.</td>
</tr>
<tr>
<td>Centigrade/Fahrenheit</td>
<td>Centigrade (°C)/Fahrenheit (°F)</td>
<td>Centigrade</td>
<td>Setting Range depends on selecting Centigrade or Fahrenheit.</td>
</tr>
</tbody>
</table>

#### 17.2.2. Signal processing box (mixer view)

#### Automix Gate, Gate All

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice ON/OFF</td>
<td>On, Off</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Gate Threshold</td>
<td>−50 dB to 20 dB in 1 dB steps</td>
<td>−40 dB</td>
<td></td>
</tr>
<tr>
<td>Gate Hysteresis</td>
<td>0 dB to 10 dB in 1 dB steps</td>
<td>0 dB</td>
<td></td>
</tr>
<tr>
<td>Gate Depth</td>
<td>−∞, −69 dB to 0 dB in 1 dB steps</td>
<td>−20 dB</td>
<td></td>
</tr>
<tr>
<td>Gate Hold</td>
<td>10, 20, 50, 70, 100, 120, 150, 200, 250, 300, 500, 700, 1000, 2000, 3000, 5000, 10000 (ms)</td>
<td>10 ms</td>
<td></td>
</tr>
<tr>
<td>Gate Attack</td>
<td>10, 20, 50, 70, 100, 120, 150, 200, 250, 300, 500, 700, 1000, 2000, 3000, 5000, 10000 (ms)</td>
<td>10 ms</td>
<td></td>
</tr>
<tr>
<td>Gate Release</td>
<td>10, 20, 50, 70, 100, 120, 150, 200, 250, 300, 500, 700, 1000, 2000, 3000, 5000, 10000 (ms)</td>
<td>10 ms</td>
<td></td>
</tr>
<tr>
<td>Gate ON/OFF</td>
<td>On, Off</td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>
### Automix Ducker

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ducker Priority Level</td>
<td>On, Off</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Ducker Depth</td>
<td>$-\infty$, $-69$ dB to 0 dB in 1 dB steps</td>
<td>$-20$ dB</td>
<td></td>
</tr>
<tr>
<td>Ducker Attack</td>
<td>10, 20, 50, 70, 100, 120, 150, 200, 250, 300, 500, 700, 1000, 2000, 3000, 5000, 10000 (ms)</td>
<td>10 ms</td>
<td></td>
</tr>
<tr>
<td>Ducker Release</td>
<td>10, 20, 50, 70, 100, 120, 150, 200, 250, 300, 500, 700, 1000, 2000, 3000, 5000, 10000 (ms)</td>
<td>10 ms</td>
<td></td>
</tr>
<tr>
<td>Ducker ON/OFF</td>
<td>On, Off</td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>

### Fader

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fader</td>
<td>$-\infty$, $-69.9$ dB to 10.0 dB in 1 dB steps</td>
<td>0 dB</td>
<td></td>
</tr>
<tr>
<td>Fader ON/OFF</td>
<td>On, Off</td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>

### Matrix

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assignment ON/OFF</td>
<td>On, Off</td>
<td>On</td>
<td>Set to ON when assigning the following cross points between inputs and outputs. Input channels: Analog In 1, Analog In 2, CobraNet In 1, CobraNet In 2, CobraNet In 3, CobraNet In 4. Output channels: Mix Out 1, Mix Out 2</td>
</tr>
</tbody>
</table>

### Mix Out Fader

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fader</td>
<td>$-\infty$, $-69.9$ dB to 10.0 dB in 0.1 dB steps</td>
<td>0 dB</td>
<td></td>
</tr>
<tr>
<td>Fader ON/OFF</td>
<td>On, Off</td>
<td>On</td>
<td></td>
</tr>
</tbody>
</table>
17.2.3. Beam Steering parameter (Beam Steering view)

### [Speaker setting]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position (X)</td>
<td>0.00 m to 200.00 m in 0.5 dB steps</td>
<td>0.00 m</td>
<td></td>
</tr>
<tr>
<td>Position (Y)</td>
<td>0.00 m to 200.00 m in 0.5 dB steps</td>
<td>0.00 m</td>
<td></td>
</tr>
<tr>
<td>Setting Origin</td>
<td>Back (Upper, Lower) Front (Upper, Lower)</td>
<td>Front (Upper)</td>
<td></td>
</tr>
<tr>
<td>Setting Angle</td>
<td>−30° to 30° in 1 dB steps</td>
<td>0°</td>
<td></td>
</tr>
</tbody>
</table>

### [Steering setting]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beam Angle</td>
<td>−45° to 45° in 1 dB steps</td>
<td>0°</td>
<td>When “Divide Beam” is enabled, Beam Angle ≥ Second Beam Angle relation is retained.</td>
</tr>
<tr>
<td>Beam Width</td>
<td>0° to 45° in 1 dB steps</td>
<td>0°</td>
<td></td>
</tr>
<tr>
<td>Divide Beam</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Unchecked (inactive)</td>
<td></td>
</tr>
</tbody>
</table>
| Beam Angle (Second Beam Angle)    | −45° to 45° in 1 dB steps            | 0°              | • Settable only when “Divide Beam” is active.  
• Beam Angle ≥ Second Beam Angle relation is retained. |
| Beam Width (Second Beam Angle)    | 0° to 45° in 1 dB steps              | 0°              | Settable only when “Divide Beam” is active.                          |

### [Space Setting]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Space Depth (X Direction)</td>
<td>10 m to 200 m in 1 dB steps</td>
<td>20 m</td>
<td></td>
</tr>
</tbody>
</table>

### [Audience Setting]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audience 1</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Unchecked (inactive)</td>
<td>Settable only when “Audience 1” is active.</td>
</tr>
<tr>
<td>Audience 1 Front and Back (X)</td>
<td>0 m to 200.0 m in 0.5 dB steps</td>
<td>0 m</td>
<td>Settable only when “Audience 1” is active.</td>
</tr>
<tr>
<td>Audience 1 Front and Back (Y)</td>
<td>0 m to 200.0 m in 0.5 dB steps</td>
<td>0 m</td>
<td>Settable only when “Audience 1” is active.</td>
</tr>
<tr>
<td>Audience 2</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Unchecked (inactive)</td>
<td>Settable only when “Audience 2” is active.</td>
</tr>
<tr>
<td>Audience 2 Front and Back (X)</td>
<td>0 m to 200.0 m in 0.5 dB steps</td>
<td>0 m</td>
<td>Settable only when “Audience 2” is active.</td>
</tr>
<tr>
<td>Audience 2 Front and Back (Y)</td>
<td>0 m to 200.0 m in 0.5 dB steps</td>
<td>0 m</td>
<td>Settable only when “Audience 2” is active.</td>
</tr>
</tbody>
</table>

### [Frequency]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Freq</td>
<td>500 Hz, 1000 Hz, 2000 Hz, 4000 Hz</td>
<td>2000 Hz</td>
<td></td>
</tr>
</tbody>
</table>
## Spl Range Setting

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max</td>
<td>50 to 150</td>
<td>120</td>
<td></td>
</tr>
<tr>
<td>Volume</td>
<td>30 to 100</td>
<td>35</td>
<td></td>
</tr>
</tbody>
</table>

## 17.2.4. System tree view

### [Stack list]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stack</td>
<td>0 – 4 stacks</td>
<td>No stack</td>
<td></td>
</tr>
</tbody>
</table>

### [Stack]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stack Name</td>
<td>16 alphanumeric characters</td>
<td>Stack (1) to Stack (4)</td>
<td></td>
</tr>
<tr>
<td>Speaker</td>
<td>1 – 4 speakers</td>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

### [Speaker]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speaker name</td>
<td>16 alphanumeric characters</td>
<td>Speaker 1 to Speaker 4</td>
<td></td>
</tr>
<tr>
<td>IP Address</td>
<td>IPv4</td>
<td>0.0.0.0</td>
<td></td>
</tr>
</tbody>
</table>

## 17.2.5. CobraNet routing

### [Normal: Rx Bundle]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>16 alphanumeric characters</td>
<td>Source 1 to Source 8</td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td>0, 1 to 65279</td>
<td>0</td>
<td>0: No bundle setting 1 to 255: Multicast 256 to 65279: Unicast</td>
</tr>
</tbody>
</table>

### [Normal: Tx Bundle]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>0, 1 to 65279</td>
<td>0</td>
<td>0: No bundle setting 1 to 255: Multicast 256 to 65279: Unicast</td>
</tr>
<tr>
<td>Output Selector</td>
<td>Mute, Mix Out (Delay OFF), Analog In (Delay OFF), Mix Out (Delay ON), Analog In (Delay ON)</td>
<td>Mute</td>
<td></td>
</tr>
</tbody>
</table>

### [Normal: CobraNet Routing]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>ON/OFF</td>
<td>On, Off</td>
<td>Off</td>
<td></td>
</tr>
</tbody>
</table>
### Advanced: CobraNet Routing

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bundle number</td>
<td>0, 1 to 65279</td>
<td>0</td>
<td>0: No bundle setting 1 to 255: Multicast</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>256 to 65279: Unicast</td>
</tr>
<tr>
<td>CobraNet Input Selector</td>
<td>On, Off</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Output Selector</td>
<td>Mute, Mix Out (Delay OFF), Analog In (Delay OFF), Mix Out (Delay ON), Analog In (Delay ON)</td>
<td>Mute</td>
<td></td>
</tr>
</tbody>
</table>

#### 17.2.6. Grouping setting

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>None, G.1 to G.16</td>
<td>The smallest group number among those not used when stack was created</td>
<td>Delay cannot be set to &quot;None.&quot;</td>
</tr>
</tbody>
</table>

#### 17.2.7 preset

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Name</td>
<td>16 alphanumeric characters</td>
<td>Preset 1 to Preset 32</td>
<td></td>
</tr>
</tbody>
</table>

#### 17.2.8 Security Setting and Box Write protect

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable User Level</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Unchecked (inactive)</td>
<td></td>
</tr>
<tr>
<td>An addition or deletion of a stack</td>
<td>Off, Low, Mid, High</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Name change of a stack and a speaker</td>
<td>Off, Low, Mid, High</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Changing the beam steering</td>
<td>Off, Low, Mid, High</td>
<td>Off</td>
<td></td>
</tr>
<tr>
<td>Store Preset</td>
<td>Off, Low, Mid, High</td>
<td>Off</td>
<td>Set for individual Presets 1 – 32</td>
</tr>
</tbody>
</table>
### Setting Item

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mute</td>
<td>Off, Low, Mid, High</td>
<td>Off</td>
<td>Set for each speaker</td>
</tr>
<tr>
<td>Gain</td>
<td>Off, Low, Mid, High</td>
<td>Off</td>
<td>Set for each speaker</td>
</tr>
<tr>
<td>LPF/HPF</td>
<td>Off, Low, Mid, High</td>
<td>Off</td>
<td>Set for each speaker</td>
</tr>
<tr>
<td>Filter</td>
<td>Off, Low, Mid, High</td>
<td>Off</td>
<td>Set for each speaker</td>
</tr>
<tr>
<td>Comp.</td>
<td>Off, Low, Mid, High</td>
<td>Off</td>
<td>Set for each speaker</td>
</tr>
<tr>
<td>Delay</td>
<td>Off, Low, Mid, High</td>
<td>Off</td>
<td>Set for each speaker</td>
</tr>
</tbody>
</table>

### 17.2.9. Log

#### [Operation Log Setting]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open And Save</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Checked (active)</td>
<td></td>
</tr>
<tr>
<td>Project</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Load Preset</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Checked (active)</td>
<td></td>
</tr>
<tr>
<td>Store Preset</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Checked (active)</td>
<td></td>
</tr>
<tr>
<td>Sync Preset</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Checked (active)</td>
<td></td>
</tr>
<tr>
<td>Modify Stack</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Checked (active)</td>
<td></td>
</tr>
<tr>
<td>Connect And Disconnect</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Checked (active)</td>
<td></td>
</tr>
</tbody>
</table>

#### [Error Log Setting]

<table>
<thead>
<tr>
<th>Setting Item</th>
<th>Setting Range</th>
<th>Default Setting</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Temperature Error</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Checked (active)</td>
<td></td>
</tr>
<tr>
<td>Over Current</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Checked (active)</td>
<td></td>
</tr>
<tr>
<td>CobraNet DSP Error</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Checked (active)</td>
<td></td>
</tr>
<tr>
<td>DSP Error</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Checked (active)</td>
<td></td>
</tr>
<tr>
<td>Fault Status</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Checked (active)</td>
<td></td>
</tr>
<tr>
<td>Network Error</td>
<td>Checked (active), Unchecked (inactive)</td>
<td>Checked (active)</td>
<td></td>
</tr>
</tbody>
</table>

---

**Traceability Information for Europe**

<table>
<thead>
<tr>
<th>Manufacturer: TOA Corporation</th>
<th>7-2-1, Minatojima-Nakamachi, Chuo-ku, Kobe, Hyogo, Japan</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorized representative:</td>
<td>TOA Electronics Europe GmbH</td>
</tr>
<tr>
<td></td>
<td>Suederstrasse 282, 20537 Hamburg, Germany</td>
</tr>
</tbody>
</table>

**URL:** [http://www.toa.jp/](http://www.toa.jp/)